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Вступ 

У результаті інтеграції інформатики, що в процесі поступового 

еволюціонування виокремилася з математики і картографії та бер е свої витоки з 

географії, утворився новий науковий напрямок – геоінфор матика, який поєднує 

науково-методологічні принципи, підходи та методи картографічної науки і 

широкі аналітичні можливості інформатики. Така інтеграція забезпечує 

об’єктивне відображення дійсності шляхом побудови геопросторових моделей –  

географічних карт на основі галузевої інформаційної структури баз та банків 

даних. 

Розвиток геоінформатики зумовлений необхідністю створення оптимальних 

концептуальних, технічних та організаційних умов для проведення різноманітних 

геологічних, геоморфологічних, гідрологічних, океанографічних, 

метеорологічних, кліматологічних, ландшафтних, демографічних, етнологічних та 

інших географічних досліджень, що вимагає залучення значних інформаційних 

масивів даних, які поєднують просторові та атрибутивні характеристики 

географічних об’єктів. 

Потужні аналітичні можливості сучасних геоінформаційних систем (ГІС), що 

забезпечують проведення картометричних, селективних, маніпулятивних та 

логічних операцій, а також операцій просторового, статистичного, оверлейного, 

мережевого та інших видів аналізу, дозволяють створювати різноманітні 

картографічні моделі (цифрові, електронні, комп’ютерні карти, віртуальні 

геозображення, картографічні анімації, WEB-карти тощо), що відповідають 

вимогам користувачів. 

Якщо інформаційну систему можна кваліфікувати як систему, що виконує 

процедури з даними для отримання інформації і використовується для прийняття 

рішень, то геоінформаційну систему слід кваліфікувати як інформаційну систему, 

що використовує географічно координовані дані та забезпечує збір, збереження, 

обробку, доступ, відображення і розповсюдження геопросторових даних. 

Сучасна тематична ГІС – це комплексна автоматизована система, що поєднує 

множину просторових і атрибутивних баз даних та аналітичні можливості 

моделювання, маніпулювання і відображення геоданих у геопросторов ій фор мі з 

метою прийняття ефективних управлінських рішень. Тематична ГІС стр уктурно 

складається з двох основних частин: інформаційного забезпечення, до якого 

входять база геопросторових даних із системою управління та програмного 

забезпечення, що виконує функцію взаємодії між компонентами ГІС. 

Основні теоретико-методологічні та науково-практичні засади 

геоінформаційного тематичного картографування реалізовано у сучасних 

повнофункціональних комерційних настільних ГІС. З-поміж інших 

геоінформаційних систем, ГІС MapInfo Professional вирізняється 

високоінтегрованим інтерфейсом, оптимізованим набором функцій кор истувача, 
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зручною зрозумілою концепцією роботи з просторовими та атрибутивними 

даними. ГІС MapInfo Professional – класична настільна геоінформаційна система 

інформаційно-графічного типу, що забезпечує створення та редагування 

первинних електронних тематичних карт, поєднує переваги програм обробки 

геоданих, а також містить засоби аналізу та представлення даних. Відмінною 

рисою ГІС MapInfo Professional є її універсальність, що дозволяє здійснювати: 

перегляд і обробку графічних зображень; пошук за запитами; редагування і 

коригування карт; включає засоби побудови діаграм і графіків та створення 

геоінформаційних тематичних карт; спеціалізовані бібліотеки умовних знаків, 

шрифтів і заповнень, забезпечує формування легенди, підписів карти, а також 

редагування, макетування, тиражування та експортування геозображень. 

У даному лабораторному практикумі здійснено спробу узагальнення та 

уніфікації досвіду вивчення і застосування можливостей ГІС MapInfo Professional 

для вирішення комплексних завдань геопросторового аналізу, що накопичений 

авторами при викладанні курсів «Геоінформаційні системи і технології», «ГІС і 

бази даних», «Картографічні методи дослідження в географії» та «Цифрова 

картографія» на географічному факультеті Східноєвропейського національного 

університету імені Лесі Українки. 

Структура та зміст даного навчально-методичного видання повністю 

узгоджені з робочою навчальною програмою дисципліни «ГІС і бази даних» та 

відповідають вимогам галузевого стандарту вищої освіти напряму підготовки  

0801 “Геодезія та землеустрій”. 

Автори висловлюють щиру подяку колегам-науковцям, які сприяли 

написанню даного лабораторного практикуму, а також співробітникам ДП 

«Волинський науково-дослідний та проектний інститут землеустрою» та 

Головного управління Держемагенства у Волинській області за надану фахову 

консультативну допомогу. 
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Лабораторна робота № 1 

Тема: Основи роботи в ГІС Maplnfo Professional 5.0 

Мета: ознайомитись з основним і контекстним меню програми Maplnfo 

Professional 5.0; ознайомитись із функціями піктограм панелей 

інструментів Standard, Main, Drawing, Tools та робочих вікон Table, 

Map, Graph, Layout; навчитись працювати з менеджером шарів 

Layout Control; визначити можливості вибору об’єктів та 

застосування операцій обчислювальної геометрії 

Інформаційне забезпечення: електронні шари цифрової топографічної 

карти Волинської області масштабу 1:200 000 (L1.tab – L8.tab), 

електронний шар політико-адміністративного поділу України з 

поділом на райони (region.tab) 

Програмне забезпечення: географічна інформаційна система Maplnfo 

Professional 5.0, текстовий редактор Microsoft Office Word 2003 

Звітні матеріали: електронні документи з результатами аудиторної і 

самостійної роботи та їх паперові аналоги 

Термін виконання: 4 год 

Порядок виконання роботи 

1. За допомогою стандартних засобів операційної системи: через меню Пуск, 

піктограмою на робочому столі або на панелі Быстрый запуск 

(Пуск → Программы → GIS → MapІnfo → MapІnfo  Professional 5.0) 

запустіть програму ГІС MapInfo Professional 5.0. На початку сеансу роботи 

з геоінформаційною системою MapInfo Professional 5.0 слід відмовитись 

від відкриття попередньої сесії роботи з програмою, робочого простору та 

окремого шару електронної карти. Для цього у  діалоговому вікні Start Up 

натисніть Cancel. 

2. Ознайомтесь з головним та контекстним меню програми. Користуючись 

контекстною підказкою, визначте функціональне призначення піктограм 

панелей інструментів Standard, Main, Drawing та розташуйте їх 

відповідно до поданого зразка (рис. 1.1). 

 
Рис. 1.1. Розташування панелей інструментів 

3. Завантажте цифрову топографічну карту Волинської області, що створена 

на основі розподілених видавничих оригіналів (пластик) карт масштабу 

1:200 000 у геодезичній системі координат 1942 року і Балтійській системі 

висот з висотою січення рельєфу – 20 та 40 м та середньоквадратичною 

похибкою визначення планового положення об'єктів і контурів місцевості 
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– ±0.3-0.4 мм у масштабі карти. До складу цифрової топографічної карти 

Волинської області масштабу 1:200 000 входять вісім базових шарів, 

структуру яких наведено у табл. 1.1. Почергово відкрийте їх файли L1.tab 

– L8.tab з папки Мои документы \ Data \ 200. 

Таблиця 1.1 

Структура шарів цифрової топографічної карти 

Характеристика шару Назва файлу 

Опорні пункти L1 . tab 

Рельєф L2 . tab 

Гідрографія L3 . tab 

Населені пункти L4 . tab 

Промислові, сільськогосподарські та 

соціально-культурні об'єкти 
L5 . tab 

Шляхи сполучення L6 . tab 

Рослинність L7 . tab 

Кордони L8 . tab 

4. Відповідно до розмірів робочого вікна розмістіть по центру електронну 

топографічну карту Волинської області та використовуючи піктограми 

зміни масштабу адекватно відобразіть її у полі картографічного вікна Мар. 

5. За допомогою кнопок Up та Down розмістіть шари електронної карти 

відповідно до встановленого зразка. При цьому шар L8 повинен бути 

нижнім у списку відкритих шарів (рис. 3.1.2). Активація менеджеру шарів 

здійснюється командою головного меню Map → Layer Control….  

 
Рис. 1.2. Розташування шарів електронної карти 
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6. Проаналізуйте опис атрибутів кожного з шарів топографічної карти 

Волинської області масштабу 1 : 200 000 (табл. 1.2). Визначте, які поля 

відповідають за власні назви та абсолютні висоти об'єктів відповідного 

шару. 

Таблиця 1.2 

Опис шарів та атрибутів об'єктів цифрової топографічної карти 

Назва 
файлу 

Назва шару 
Назва 

атрибуту 

шару 

Значення атрибуту 

L1 . tab Опорні пункти 
р127 код топографічного об’єкта 

р4 абсолютна висота 

L2 . tab Рельєф 

р127 код топографічного об’єкта 

p1 відносна висота  

p4 абсолютна висота 

p7 глибина 

L3 . tab Гідрографія 

р127 код топографічного об’єкта 

p1 відносна висота  

p3 стан 

p4 абсолютна висота 

p9 власна назва 

p15 ширина за шкалою 

p35 
характер розташування об’єкта 

відносно вихідної поверхні 

p36 характер берегової лінії 

p57 розташування об’єкта 

L4 . tab Населені пункти 

р127 код топографічного об’єкта 

p9 власна назва 

p9u власна назва (українською) 

L5 . tab 

Промислові, 
сільськогосподар-
ські та соціально-

культурні об'єкти 

р127 код топографічного об’єкта 

p1 відносна висота  

p7 глибина 

p9 власна назва 
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Назва 

файлу 
Назва шару 

Назва 

атрибуту 
шару 

Значення атрибуту 

p35 
характер розташування об’єкта 

відносно вихідної поверхні 

p72 внутрішня структура об’єкта 

L6 . tab Шляхи сполучення 

p127 код топографічного об’єкта 

p1 відносна висота  

p3 стан 

p7 глибина 

p9 власна назва 

p51 кількість колій 

p54 вид тяги 

p57 розташування об’єкта 

L7 . tab Рослинність 

p127 код топографічного об’єкта 

p9 власна назва 

p57 розташування об’єкта 

L8 . tab Кордони 

p127 код топографічного об’єкта 

p9 власна назва 

p67 тип кордону 

p74 географічний термін 

 

7. Використовуючи менеджер шарів Layer Control виведіть підписи 

населених пунктів із наступними параметрами: власна назва – поле р9u; 

тип шрифту – Arial CYR; розмір кегля – 12; стиль – Bold та Shadow; колір  

– червоний, відступ 5 пт на схід від його центроїда (при цьому слід 

враховувати, що підписи населених пунктів зі зміною масштабу 

генералізуються). Для цього у менеджері шарів виберіть шар населених 

пунктів L4, активуйте прапорець маркування шару Auto Label та натисніть 

кнопку Label (рис. 1.3). 

8. Використовуючи піктограми зміни масштабу та зсуву зображення 

електронної карти розташуйте оз. Світязь та прилеглу до нього територію 

на усю робочу область вікна ГІС MapІnfo Professional 5.0. Результат 

роботи порівняйте із зразком, що поданий на рис 1.4. 
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Рис. 1.3. Налаштування підписів шару населених пунктів 

 
Рис. 1.4. Відображення оз. Світязь та прилеглої до нього території 

9. Використовуючи менеджер шарів Layer Control змініть параметри 

оформлення об'єктів шару населених пунктів: відмініть відображення 

точкових та лінійних об'єктів шару населених пунктів; змініть колір 

заповнення площинних об'єктів населених пунктів на оранжевий, змініть 

колір ліній контуру площинних об'єктів населених пунктів на червоний та 

виведіть відображення центроїдів площинних об'єктів населених пунктів. 

Для цього у менеджері шарів виберіть шар населених пунктів L4 та 

натисніть Display. У діалоговому вікні L4 Display Options встановіть 

параметри оформлення згідно зразка, що поданий на рис. 1.5. 



 12 

 
Рис. 1.5. Налаштування оформлення контурів та текстури площинних 

об'єктів шару населених пунктів 

10. Використовуючи піктограму вибору об'єктів визначте: географічні 

координати центру оз. Світязь; координати прямокутної рамки, у яку 

вписується даний географічний об'єкт; кількість лінійних сегментів, що 

формують даний географічний об'єкт; а також його площу і периметр.  Для 

цього наведіть маркер миші на відповідний географічний об'єкт та двічі 

натисніть ліву кнопку миші. Результати порівняйте зі зразком, що поданий 

на рис. 1.6.  

 
Рис. 1.6. Відображення оз. Турське та с. Броди з прилеглою територією 
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11. Використовуючи піктограму лінійка визначте відстань між центроїдами 

населених пунктів Пульмо–Шацьк, Шацьк–Світязь і Світязь–Пульмо. 

Наведіть маркер лінійки на відповідний центр початкового географічного 

об'єкту, подвійним кліком лівої кнопки миші зафіксуйте початок 

вимірювання, а тоді перемістіть маркер лінійки на відповідний центр 

кінцевого географічного об'єкту та зафіксуйте кінець вимірювання. При 

цьому результат вимірювання відобразиться в інформаційному вікні Ruler. 

Результати вимірювань порівняйте з еталонними: 10.44 км, 6.58 км і 5.77 

км. Вихід з режиму вимірювання здійснюється за допомогою клавіші Esc. 

12. Використовуючи піктограму лінійка визначте найкоротшу відстань 

вздовж шляхів сполучення між межами населених пунктів Пульмо–Шацьк 

та Шацьк–Світязь. Для цього наведіть маркер лінійки на відповідний 

перетин контуру географічного об'єкту та шляху сполучення, подвійним 

кліком лівої кнопки миші зафіксуйте початок вимірювання, а тоді 

перемістіть маркер лінійки вздовж шляху сполучення до поворотних точок 

шляху сполучення, кожну з яких, як і кінцеву точку зафіксуйте. При цьому 

результат вимірювання відобразиться в інформаційному вікні Ruler. 

Результати вимірювань порівняйте з еталонними: 10.00 км та 1.38 км. 

Вихід з режиму вимірювання здійснюється за допомогою клавіші Esc. 

13. Використовуючи менеджер шарів Layer Control виведіть підписи об'єктів 

гідрографії із наступними параметрами: власна назва – поле р9; тип шрифту 

– Arial CYR; розмір кегля – 10; стиль – Italic; колір – синій, відступ – 2 пт 

на північ від його центроїда. Для цього у менеджері шарів виберіть шар 

об’єктів гідрографії L3, активуйте прапорець маркування шару Auto Label 

та натисніть кнопку Label. У діалоговому вікні L3 Label Options 

встановіть параметри оформлення підписів даного шару. 

14. Використовуючи піктограми зміни масштабу та зсуву зображення 

електронної карти розмістіть географічні об’єкти оз.  Турське та с. Броди з 

прилеглою територією на всю робочу область ГІС MapІnfo Professional 

5.0. Результат роботи порівняйте із зразком, що представлений на рис 1.6.  

15. Використовуючи піктограму вибору об'єктів визначте сумарну площу 

оз. Турське, оз. Велихове та оз. Дружби. Результати вимірювань порівняйте 

з еталонними значеннями (10.97 + 0.06686 +0.2798 = 11.31666 км2). 

16. Використовуючи піктограму лінійка визначте довжину каналу Турський 

від оз. Турського до об’єкту гідрографії, що розміщений на північний захід 

від с Броди. Результат вимірювання порівняйте з еталонним значенням 

(14.66 км). 

17. Запустіть програму MS Word. Використовуючи правила оформлення у 

даному текстовому редакторі сформуйте документ результатів 

лабораторної роботи № 1 і оформіть його відповідно до поданого зразка 

(рис. 1.7). У папці Мои документы \ Data \ Stud збережіть новостворений 

документ під унікальним іменем (наприклад, Пацюкевич_GIS_1.doc, де 



 14 

Пацюкевич – прізвище студента, GIS – предмет, 1 – номер лабораторної 

роботи). 

18. Визначте: географічні координати центрів населених пунктів Луцьк, 

Ковель, Рожище, Турійськ, Локачі, Любомль, Шацьк; координати 

прямокутних рамок, в які вписуються дані географічні об'єкти; кількість 

лінійних сегментів, що формують дані географічні об'єкти; а також їх 

площу і периметр. Результати роботи занесіть до відповідної таблиці у 

текстовому документі Пацюкевич_GIS_1.doc і збережіть його. 

19. Визначте попарні відстані між населеними пунктами Луцьк, Ковель, 

Рожище, Турійськ, Локачі, Любомль, Шацьк. Результати роботи занесіть 

до відповідної таблиці у текстовому документі Пацюкевич_GIS_1.doc і 

збережіть його. 

20. Визначте найкоротшу відстань вздовж шляхів сполучення між центроїдами 

населених пунктів Луцьк, Ковель, Рожище, Турійськ, Локачі, Любомль, 

Шацьк. Результати роботи занесіть до відповідної таблиці у текстовому 

документі Пацюкевич_GIS_1.doc і збережіть його. 

21. Визначте сумарну площу озер Луки, Пулемецьке та Пісочне. Результати 

роботи занесіть до відповідної таблиці у текстовому документі 

Пацюкевич_GIS_1.doc і збережіть його. 

22. Визначте довжину та кількість правих і лівих приток р.  Полонка між 

межами населених пунктів с. Гадь та с. Гірка Полонка (Луцький район). 

Результати роботи занесіть до відповідної таблиці у текстовому документі 

Пацюкевич_GIS_1.doc і збережіть його. 

23. Закрийте програму MS Word. 

24. Закрийте усі активні шари карти та програму MapInfo Professional 5.0. 
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Лабораторна робота №1 

Завдання аудиторної роботи  

Картометричні показники  

населених пунктів Волинської області 

Картометричні 

показники 

Населені пункти 

Ковель Горохів Луцьк Маневичі Іваничі Ратне Шацьк 

Географічні 
координати 

центроїда 

B        

L        

Координати 

прямокутної 

рамки 

B1        

B2        

L1        

L2        

Кількість 

лінійних 

сегментів 

       

Площа        

Периметр        

 

Відстань між центроїдами  

населених пунктів Волинської області 

Найкоротша відстань між центроїдами  

населених пунктів 

 Найкоротша відстань між центроїдами 

населених пунктів вздовж шляхів 

сполучення 
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Луцьк                Луцьк 

Ковель                Ковель 

Рожище                Рожище 

Турійськ                Турійськ 

Локачі                Локачі 

Любомль                Любомль 

Шацьк                Шацьк 

 

Площа озер Волинської області 

Характеристика 
Озера 

Луки Пулемецьке Пісочне 

Площа, км2    

Сумарна площа, км2  

 

Довжина та кількість правих і лівих приток р. Полонка  

між межами населених пунктів с Гадь і  с. Гірка Полонка Волинської області 

Річка 
Довжина, 

км 

Кількість приток 

правих лівих 

Полонка    
 

Перевірив:        Виконав:     
(Прізвище та ініціали викладача)               (Прізвище та ініціали студента) 

Оцінка:        Дата:           

Рис. 1.7. Приклад оформлення документу аудиторної роботи у текстовому 
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редакторі MS Word 

Завдання для самостійної роботи 

Використовуючи цифрову топографічну карту Волинської області масштабу 

1:200 000 у середовищі ГІС MapІnfo Professional 5.0 згідно варіанту визначити: 1 – 

географічні координати центроїдів населених пунктів; координати кутів 

прямокутної рамки, у яку вписується даний населений пункт; кількість лінійних 

сегментів, що формують даний населений пункт; а також площу та периметр 

населеного пункту; 2 – найкоротшу відстань між центроїдами населених пунктів; 

3 – найкоротшу відстань між межами населених пунктів вздовж шляхів 

сполучення; 4 – найкоротшу відстань між центроїдами населених пунктів вздовж 

шляхів сполучення. Використовуючи правила оформлення у текстовому редакторі 

MS Word сформувати документ із результатами виконання завдань самостійної 

роботи і оформити його відповідно до поданого зразка (рис.1.8).  

Варіанти завдань для самостійної роботи 
№ 

варіа

нтів 

Назви районів Назви населених пунктів 

1 
Володимир-

Волинський 

1 – Кладнів, Ліски, Міжлісся, Нехвороща, Октавин, Амбуків, 

Устилуг 

2 – Лудин-Свійчів, Нехвороща-Пархоменкове, Новини-Бубнів 

3 – Рокитниця-Лудин-Дарницьке-Хотячів 

4 – Жовтневе-Красностав-Галинівка-Свійчів 

2 Горохівський 

1 – Бужани, Смолява, Угринів, Ватинець, Козятин, Квасів, 

Мар'янівка 

2 – Пустомити-Галичани, Мирків-Липа, Журавники-Диковини 

3 – Підбереззя-Пірванче-Горохів-Холопів 

4 – Сільце-Бужани-Борочиче-Мар'янівка 

3 Іваничівський 

1 – Кречів, Бортнів, Бужковичі, Топилище, Самоволя, Лугове, 

Шахтарське 

2 – Литовеж-Орищі, Переславичі-Бужанка, Грушів-Іванів 

3 – Поромів-Шахтарське-Грибовиця-Соснина 

4 – Луковичі-Орищі-Радовичі-Клопочин 

4 
Камінь-

Каширський 

1 – Катуш, Ворокомле, Оленине, Карпилівка, Запруддя, Залісся, 

Бузаки 

2 – Качин-Фаринки, Боровне-Видричі, Верхи-Черче 

3 – Вндричі-Бузаки-Раків Ліс-Камінь-Каширський 

4 – Соснівка-Пнівне-Брониця-Камінь-Каширський 

5 Ківерцівський 

1 – Липне, Макаревичі, Завітне, Липляни, Котів, Горянівка, 

Грем'яче 

2 – Яківці-Клепачів, Муравище-Берестяне, Хопнів-Метельне 

3 – Городище-Сильне-Журавичі-Макаревичі 

4 – Пальче-Хорлупи-Покащів-Одеради 

6 Ковельський 

1 – Голоби, Грушівка, Поворськ, Підріжжя, Доротище, 

Красноволя, Волошки 

2 – Старі Кошари-Солотвин, Грушівка-Ситовичі, Зелена-

Черемошне 

3 – Свидники-Голоби-Воля Любитівська-Колодяжне 

4 – Ломачанка-Кричевичі-Уховецьк-Ковель 
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№ 

варіа

нтів 

Назви районів Назви населених пунктів 

7 Локачинський 

1 – Колпитів, Замличі, Губин, Твердині, Затурці, Линів, Твориничі 

2 – Кисилин-Новий Загорів, Білопіль-Тумин, Мовчанів-Колпитів 

3 – Юнівка-Затурці-Маньків-Холопичі 

4 – Конюхи-Привітне-Коритниця-Бубнів 

8 Луцький 

1 – Рокині, Хорохорин, Садів, Воютин, Радомишль, Вербаїв, 

Воротнів 

2 – Веселе-Несвіч, Білосток-Лучиці, Моташівка-Боратин 

3 – Воютин-Білосток-Торчин-Веселе 

4 – Мстишин-Вербаїв-Коршовець-Промінь 

9 Любешівський 

1 – Невір, Гірки, Пожог, Лобна, Діброва, Мала Глуша, Цир 

2 – Гірки-Седлище, Щитинь-Залізниця, Березичі-Люботин 

3 – Ветли-Невір-Велика Глуша-Мала Глуша 

4 – Лобна-Березичі-Любешів-В'язівне 

10 Любомльський 

1 – Мосир, Гуща, Забужжя, Крушинець, Почапи, Олеськ, Лисняки 

2 – Висоцьк-Черемошна Воля, Гупали-Глинянка, Рівне-Радехів. 

3 – Вишнівка-Гуща, Борове-Запілля 

4 – Чорноплеси-Вигнанка-Почапи-Руда 

11 Маневицький 

1 – Четвертня, Майдан, Нова Руда, Серхів, Вовчицьк, Тельчі, 

Гораймівка 

2 – Майдан-Липненський-Черськ, Карасин-Ситниця, Грузятин-

Козлиничі 

3 – Черськ-Троянівка-Градиськ-Нова Руда 

4 – Лісове-Гута-Лісівська-Кам'януха-Рудка 

12 Ратнівський 

1 – Датинь, Гута, Тур, Самари, Хабирище, Річиця, Адамівка, 

Замшани 

2 – Дошне-Тур, Гута-Щедрогір, Височне-Зоряне 

3 – Гута-Заболоття-Тур-Жиричі 

4 – Вужиськ-Замшани-Видраниця-Заіванове 

13 Рожищенський 

1 – Вітоніж, Береськ, Уляники, Тростянка, Вишеньки, Навіз, 

Раймісто 

2 – Студині-Кобче, Немир-Дубище, Береськ-Мильськ 

3 – Вітоніж-Ясенівка-Немир-Бортяхівка 

4 – Трилісці-Переспа-Кременець-Копачівка 

14 
Старовижів–

ський 

1 – Паридуби, Любохини, Глухи, Брунетівка, Грабове, Мизове, 

Смолярі 

2 – Сукачі-Шкроби, Журавлине-Лютка, Кримне-Смідин 

3 – Паридуби-Журавлине-Мизове-Секунь 

4 – Любохини-Кримне-Мокре-Дубечне 

15 Турійський 

1 – Комарів, Ставки, Оса, Маковичі, Ловища, Озеряни, Дуліби 

2 – Турія-Луків, Ловища-Крать, Дольськ-Мочалки 

3 – Ставки-Крать-Овлочин-Туричани 

4 – Турійськ-Радовичі-Туличів-Купичів 

16 Шацький 

1 – Хрипськ, Прип'ять, Положеве, Адамчуки, Кошари, Мельники, 

Піща 

2 – Ростань-Плоске, Грабове-Мельники, Пулемець-Прип'ять 

3 – Кошари-Залісся-Підманове-Світязь 

4 – Мельники-Шацьк-Вілиця-Прип'ять 
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Лабораторна робота №1 

Завдання самостійної роботи  

Варіант № 1 

Картометричні показники  

населених пунктів Володимир-Волинського району 

Картометричні 

показники 

Населені пункти 

Кладні

в  

Ліск

и 

Міжлісс

я 

Нехворощ

а 

Октави

н 

Амбукі

в 

Устилу

г 

Географічні 

координати 

центроїда 

B        

L        

Координати 

прямокутно

ї рамки 

B

1 
       

B

2 
       

L

1 
       

L

2 
       

Кількість 

лінійних 

сегментів 

       

Площа        

Периметр        

 

Найкоротша відстань між центроїдами населених пунктів  

Володимир-Волинського району 

 

Картометричний 

показник 

Населені пункти 

Лудин – 

Свійчів 

Нехвороща – 

Пархоменкове 

Новини 

– Бубнів 

Відстань, км    

 

Найкоротша відстань між межами населених пунктів вздовж шляхів сполучення  

Володимир-Волинського району 

 

Картометричний 

показник 

Шлях сполучення 

Рокитниця – Лудин – Дарницьке – 

Хотячів 

Відстань, км  

 

 

Найкоротша відстань між центроїдами населених пунктів вздовж шляхів сполучення  

Володимир-Волинського району 

 

Картометричний 

показник 

Шлях сполучення 

Жовтневе – Красностав – Галинівка – 

Свійчів 

Відстань, км  

 

Перевірив:        Виконав:     
(Прізвище та ініціали викладача)               (Прізвище та ініціали студента) 

Оцінка:        Дата:           
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Рис. 3.1.8. Приклад оформлення документу результатів самостійної роботи  

у текстовому редакторі MS Word (для варіанту №1) 

Лабораторна робота № 2 

Тема: Макетування електронної карти засобами Maplnfo Professional 5.0 

Мета: навчитись виконувати комбінування шарів електронної карти при 

створенні додрукового макету Maplnfo Professional 5.0, здійснювати 

оформлення додрукового макету із застосуванням елементів ділової 

комп’ютерної графіки та виведення його на друк 

Інформаційне забезпечення: електронні шари цифрової топографічної 

карти Волинської області масштабу 1:200 000 (L3.tab, L4.tab, L6.tab, 

L8.tab), електронний шар політико-адміністративного поділу України 

з поділом на райони (District.tab) 

Програмне забезпечення: географічна інформаційна система Maplnfo 

Professional 5.0 

Звітні матеріали: електронні документи робочих просторів з р езультатами 

аудиторної і самостійної роботи та їх паперові аналоги 

Термін виконання: 4 год 

Порядок виконання роботи 

1. За допомогою стандартних засобів операційної системи: через меню Пуск, 

піктограмою на робочому столі або на панелі Быстрый запуск 

(Пуск → Программы → GIS → MapІnfo → MapІnfo Professional 5.0) 

запустіть програму ГІС MapInfo Professional 5.0. На початку сеансу 

роботи з геоінформаційною системою MapInfo Professional 5.0 слід 

відмовитись від відкриття попередньої сесії роботи з програмою, робочого 

простору та окремого шару електронної карти. Для цього у  діалоговому 

вікні Start Up натисніть Cancel. 

2. Завантажте електронні шари цифрової топографічної карти Волинської 

області: L3.tab (гідрографія), L4.tab (населенні пункти), L6.tab (шляхи 

сполучення), L8.tab (кордони) та District.tab (політико-адміністративний 

поділ України з поділом на райони). 

3. Розташуйте по центру електронну карту Волинської області та 

використовуючи піктограми зміни масштабу відобразіть її відповідно до 

розмірів картографічного вікна Мар. 

4. Використовуючи менеджер шарів Layer Control розмістіть шари цифрової 

топографічної карти відповідно до поданого зразка (рис. 2.1).  

5. Використовуючи менеджер шарів Layer Control виведіть підписи 

населених пунктів із наступними параметрами: власна назва – поле р9u; 

шрифт підпису – Arial CYR; розмір кегля – 12; стиль – Bold; колір – 

чорний; відступ – 5 пт на південний схід від його центроїда (при цьому 

слід враховувати, що підписи населених пунктів зі зміною масштабу 
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генералізуються). 

6. Використовуючи менеджер шарів Layer Control змініть оформлення 

контурів та текстуру площинних об'єктів шару населених пунктів з 

наступними параметрами: відмініть відображення точкових та лінійних 

об'єктів шару населених пунктів; змініть колір заповнення площинних 

об'єктів населених пунктів на світло-сірий, а колір ліній контуру – на 

темно-сірий. Для цього у менеджері шарів виберіть шар населених пунктів 

L4 та натисніть Display. У діалоговому вікні L4 Display Options встановіть 

параметри оформлення. 

 
Рис. 2.1. Розташування шарів електронної карти 

7. Використовуючи піктограму вибору окремих підписів об'єктів шару для 

населених пунктів Волинської області: Луцьк, Ковель, Рожище, Турійськ, 

Локачі, Любомль і Шацьк змініть параметри їх оформлення наступним 

чином: шрифт підпису – Arial CYR; розмір кегля – 14; стиль – Bold та 

Shadow; колір – червоний. 

8. Використовуючи піктограму вибору окремих об'єктів шару політико-

адміністративного поділу України з поділом на райони виділіть Луцький 

район. 

9. Використовуючи піктограму вирізання фрагменту площинного об’єкта 

електронної карти відобразіть електронну карту Луцького району. Вирізання 

фрагменту площинного об’єкта електронної карти здійснюється за 

допомогою піктограми Set Clip Region панелі інструментів Main. 

Результат порівняйте зі зразком, що поданий на рис. 2.2.  

10. Відновіть попереднє відображення електронної карти у вікні Map. Відміна 

вибору фрагменту площинного об’єкта  електронної карти здійснюється за 

допомогою піктограми Clip Region On/Off панелі інструментів Main. 

11. Використовуючи піктограму зміни масштабу електронної карти Change 

View встановіть масштаб карти 1:1 500 000. Зміна масштабу цифрової 

карти здійснюється командою головного меню Map → Change View. 

Розмістіть цифрову карту по центру картографічного вікна Map. У 

інформаційному рядку ГІС MapInfo Professional 5.0 встановіть виведення 

поточного значення числового масштабу карти. Для цього наведіть мар кер  

миші на лівий нижній кут вікна ГІС MapInfo Professional 5.0, де 
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відображено розмір робочої області Zoom та натиснувши ліву кнопку миші 

із запропонованого списку виберіть Map Scale. Результат порівняйте зі 

зразком, що поданий на рис. 2.3. 

 
Рис.2.2. Електронна карта Луцького району  
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Рис. 2.3. Вікно програми ГІС MapInfo Professional 5.0  

(після зміни масштабу карти) 

12. Використовуючи менеджер шарів Layer Control здійсніть вибір окремих 

об'єктів обраного шару. Для цього у колонці Selectable менеджера шарів 

Layer Control встановіть прапорець навпроти L8 (кордони) і відключіть 

селекцію об’єктів у всіх інших шарах. 

13. Використовуючи піктограму вирізання фрагменту площинного об’єкту 

електронної карти відобразіть електронний шар політико-адміністративної 

карти Волинської області з поділом на райони. Вирізання фрагменту 

площинного об’єкту електронної карти здійснюється за допомогою 

піктограми Set Clip Region панелі інструментів Main. Результат 

порівняйте зі зразком, що подано на рис. 2.4.  
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Рис. 2.4. Вікно програми ГІС MapInfo Professional 5.0 

(після вирізання фрагменту площинного об’єкта) 

14. Використовуючи стандартні засоби ГІС MapInfo Professional 5.0 

побудуйте додруковий макет електронної карти зі стандартними 

параметрами. Побудова додрукового макету електронної карти 

здійснюється за допомогою команди головного меню Window → New 

Layout Window. 

15. Встановіть параметри налаштування додрукового макету електронної 

карти із наступними параметрами: формат паперу – A4; орієнтування 

паперу – Portrait; поля – 10 мм; кількість сторінок формату – 11 сторінка 

(по горизонталі і вертикалі). Налаштування параметрів друку електронної 

карти здійснюється за допомогою команди головного меню File →  Page 

Setup. Налаштування параметрів додрукового макету електронної карти 

здійснюється за допомогою команди головного меню Layout →  Options… 

16. Встановіть масштаб фрейму електронної карти 1:1  000 000. Для зміни 

масштабу у вікні додрукового макету Layout лівою кнопкою миші 

активуйте вікно параметрів фрейму Frame Object та у полі Scale on Paper 



 24 

встановіть значення іменованого масштабу в 1 см – 10 км (рис. 2.5). 

 
Рис. 2.5. Вікно встановлення параметрів фрейму 

17. Для зміни стилю фрейму у вікні додрукового макету карти Layout 

командою головного меню Options → Region Style активуйте вікно зміни 

стилю площинного об’єкту та встановіть наступні параметри: у полі 

Pattern функціонального блоку Fill встановіть прозорий фон None, а у 

полі Style функціонального блоку Border – відсутність контуру фрейму 

None (рис. 2.6). 

 
Рис. 2.6. Вікно встановлення параметрів стилю площинного об’єкту 

18. Розташуйте фрейм електронної карти по центру активної робочої області 

додрукового макету Layout. 

19. Над фреймом електронної карти пунсонами відобразіть населенні пункти: 

Луцьк, Ковель, Рожище, Турійськ, Локачі, Любомль і Шацьк. Для цього 

використовуючи піктограму Ellipse панелі інструментів Drawing на 

додруковому макеті карти побудуйте пунсони. Подвійним натисканням 

лівої кнопки миші по пунсону у діалоговому вікні зміни стилю Ellipse 

Object встановіть наступні параметри: радіус – 33 мм; колір заповнення –  

червоний, колір контуру – чорний. 

20. Над фреймом електронної карти побудуйте неорієнтований граф 
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найкоротших відстаней між населеними пунктами: Луцьк, Ковель, 

Рожище, Турійськ, Локачі, Любомль і Шацьк. Для відображення ребер 

графа на додруковому макеті карти використовують піктограму Line панелі 

інструментів Drawing. При цьому лівою кнопкою миші фіксують початок 

лінії і кінець лінії. Подвійним натисканням лівої кнопки миші по пунсону у 

діалоговому вікні зміни стилю Line Object встановіть наступні параметри: 

стиль лінії – суцільна, колір лінії – червоний, товщина лінії – 2 пт. 

Результат порівняйте зі зразком, що поданий на рис. 2.7.  

 
Рис. 2.7. Картграф найкоротших відстаней між населеними пунктами 

21. Під фреймом електронної карти побудуйте таблицю найкоротших 

відстаней між населеними пунктами: Луцьк, Ковель, Рожище, Турійськ, 

Локачі, Любомль і Шацьк. Використовуючи піктограму Line панелі 

інструментів Drawing, лівою кнопкою миші фіксують початок лінії і 

кінець лінії. Для відображення ліній таблиці подвійним натисканням лівої 

кнопки миші по лінії у діалоговому вікні зміни стилю Line Object 

встановіть наступні параметри: стиль лінії – суцільна, колір лінії – 

чорний, товщина лінії – 1 пт. Результат порівняйте зі зразком, що поданий 

у табл.2.1. 

 

 

Таблиця 2.1. 

Найкоротші відстані між населеними пунктами 

 Луцьк Ковель Рожище 
Турійсь

к 
Локачі Любомль Шацьк 

Луцьк        

Ковель        

Рожище        

Турійськ        

Локачі        

Любомль        
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Шацьк        

22. Використовуючи результати картометричних досліджень лабораторної 

роботи № 1, заповніть таблицю найкоротших відстаней між центроїдами 

населених пунктів Волинської області: Луцьк, Ковель, Рожище, Турійськ, 

Локачі, Любомль і Шацьк. 

23. Оформлення додрукового макету виконайте за  зразком, що поданий на рис. 

3.2.8. 

24. У папку Мои документы \ Data \ Stud збережіть робочий простір під 

унікальним іменем (наприклад, Пацюкевич_GIS_2.wor, де Пацюкевич – 

прізвище студента, GIS – предмет, 2 – номер лабораторної роботи). 

25. Закрийте усі активні шари карти та програму MapInfo Professional 5.0. 
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Рис.2.8. Приклад оформлення додрукового макету аудиторної роботи №  2  
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Завдання для самостійної роботи 

Використовуючи електронні шари цифрової карти Волинської області 

засобами ГІС MapІnfo Professional 5.0, відповідно до запропонованого варіанту 

для певного адміністративного району побудувати неорієнтований граф 

найкоротших відстаней між населеними пунктами Волинської області та таблицю 

попарних відстаней між ними. Використовуючи правила оформлення 

додрукового макету у ГІС MapІnfo Professional 5.0, сформувати документ із 

результатами виконання завдань самостійної роботи і оформити його відповідно 

до поданого зразка (рис. 2.9). 

Варіанти завдань для самостійної роботи 

№ 

варі–

антів 

Назви районів Назви населених пунктів 

1 
Володимир-

Волинський 
Кладнів, Ліски, Міжлісся, Нехвороща, Октавин, Амбуків, Устилуг 

2 Горохівський 
Бужани, Смолява, Угринів, Ватинець, Козятин, Квасів, 

Мар'янівка 

3 Іваничівський 
Кречів, Бортнів, Бужковичі, Топилище, Самоволя, Лугове, 

Шахтарське 

4 
Камінь-

Каширський 

Катуш, Ворокомле, Оленине, Карпилівка, Запруддя, Залісся, 

Бузаки 

5 Ківерцівський Липне, Макаревичі, Завітне, Липляни, Котів, Горянівка, Грем'яче 

6 Ковельський 
Голоби, Грушівка, Поворськ, Підріжжя, Доротище, Красноволя, 

Волошки 

7 Локачинський Колпитів, Замличі, Губин, Твердині, Затурці, Линів, Твориничі 

8 Луцький Рокині, Хорохорин, Садів, Воютин, Радомишль, Вербаїв, Воротнів 

9 Любешівський Невір, Гірки, Пожог, Лобна, Діброва, Мала Глуша, Цир 

10 Любомльський Мосир, Гуща, Забужжя, Крушинець, Почапи, Олеськ, Лисняки 

11 Маневицький 
Четвертня, Майдан, Нова Руда, Серхів, Вовчицьк, Тельчі, 

Гораймівка 

12 Ратнівський 
Датинь, Гута, Тур, Самари, Хабирище, Річиця, Адамівка, 

Замшани 

13 Рожищенський Вітоніж, Береськ, Уляники, Тростянка, Вишеньки, Навіз, Раймісто 

14 
Старовижів–

ський 
Паридуби, Любохини, Глухи, Брунетівка, Грабове, Мизове 

15 Турійський Комарів, Ставки, Оса, Маковичі, Ловища, Озеряни, Дуліби 

16 Шацький 
Хрипськ, Прип'ять, Положеве, Адамчуки, Кошари, Мельники, 

Піща 
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Рис.2.9. Приклад оформлення додрукового макету самостійної роботи № 2  
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Лабораторна робота № 3 

Тема: Створення та редагування електронної карти засобами ГІС Maplnfo 

Professional 5.0 

Мета: навчитись створювати і редагувати структуру таблиць даних та 

наповнювати картографічну базу даних атрибутивною інфор мацією 

засобами ГІС Maplnfo Professional 5.0 

Інформаційне забезпечення: електронні шари цифрової карти України 

масштабу 1:500 000 (Ukraine.tab, Region.tab, District.tab, City.tab, 

Town.tab) 

Програмне забезпечення: географічна інформаційна система Maplnfo 

Professional 5.0 

Звітні матеріали: файли картографічної бази даних області у фор маті .tab , 

електронні документи робочих просторів з результатами аудиторної і 

самостійної роботи та їх паперові аналоги 

Термін виконання: 4 год 

Порядок виконання роботи 

1. За допомогою стандартних засобів операційної системи: через меню Пуск, 

піктограмою на робочому столі або на панелі Быстрый запуск 

(Пуск → Программы → GIS → MapІnfo → MapІnfo  Professional 5.0) 

запустіть програму ГІС MapInfo Professional 5.0. На початку сеансу 

роботи з геоінформаційною системою MapInfo Professional 5.0 слід 

відмовитись від відкриття попередньої сесії роботи з програмою, робочого 

простору та окремого шару електронної карти. Для цього у  діалоговому 

вікні Start Up натисніть Cancel. 

2. Використовуючи папку Мои документы \ Data \ Ukraine завантажте 

електронні шари цифрової карти України масштабу 1:500 000: Ukraine.tab 

(державний кордон), Region.tab (кордони областей), District.tab (кордони 

районів), City.tab (міста), Town.tab (селища міського типу). 

3. Розташуйте по центру електронну карту України та використовуючи 

піктограми зміни масштабу відобразіть її відповідно до розмірів 

картографічного вікна Мар. 

4. Використовуючи менеджер шарів Layer Control розмістіть шари цифрової 

топографічної карти відповідно до поданого зразка (рис. 3.1).  

5. Використовуючи менеджер шарів Layer Control виведіть підписи 

адміністративних областей України із наступними параметрами: власна 

назва – поле Область; шрифт підпису – Arial CYR; розмір кегля – 12; 

стиль – Bold та Shadow; колір – червоний; відступ – 2 пт по центру від 

його центроїда (при цьому слід враховувати, що підписи адміністративних 

областей зі зміною масштабу генералізуються). 
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Рис. 3.1. Розташування шарів електронної карти 

6. Використовуючи менеджер шарів Layer Control виведіть підписи 

адміністративних районів Волинської області із наступними параметрами: 

власна назва – поле Район; шрифт підпису – Arial CYR; розмір кегля –  10; 

стиль – Bold; колір – чорний; відступ – 2 пт по центру від його центроїда 

(при цьому слід враховувати, що підписи адміністративних районів зі 

зміною масштабу генералізуються). 

7. Використовуючи піктограму зміни масштабу електронної карти Change 

View встановіть масштаб карти 1:1 500 000. Зміна масштабу цифрової 

карти здійснюється за допомогою команди головного меню Map → 

Change View. Розмістіть цифрову карту Волинської області по центру 

картографічного вікна Map.  

8. Використовуючи піктограму відкриття табличного вікна New Browser або 

команду головного меню Window → New Browser Window… почергово 

ознайомтесь зі структурою та вмістом таблиць шарів Ukraine, Region та 

District електронної карти України. 

9. Закрийте табличні вікна шарів електронної карти України. 

10. Використовуючи піктограму створення нового шару New Table або 

команду головного меню File → New Table… активуйте майстер  

створення нового шару електронної карти. Для активації відкриття нових 

вікон типу Browser (Таблиця) та Map (Карта) новостворюваного шару 

електронної карти у діалоговому вікні New Table навпроти команд Open 

New Browser та Open New Mapper встановіть відповідні прапорці і 

натисніть кнопку Create... 

11. У діалоговому вікні New Table Structure відтворіть структуру шару 

адміністративних областей України. Для цього спочатку у 

функціональному блоці Field Information (Характеристика полів) у 

діалоговому рядку Name (Ім’я) вкажіть назву першого поля – Область, у 

випадаючому списку Туре (Тип) виберіть тип даних – Character 

(Символьний), у діалоговому рядку Width (Ширина) встановіть кількість 

символів – 30 і натисніть кнопку Add Field (Додавання поля). Іншим 

полем новостворюваної таблиці є поле з іменем ID та типом даних – Small 

Integer (Цілочисельний скорочений) і натисніть кнопку 
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Add Field. Аналогічно створіть поля з іменами Центр, Кількість_районів 

і Населення та типами даних Character (кількість символів 30), Small 

Integer і Float відповідно. 

12. У папці Мои документы \ Data \ Stud \  під іменем Пацюкевич_Volun.tab 

збережіть новостворену структуру таблиці бази даних шару електронної 

карти. 

13. За допомогою команди головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. У робочій області 

програми відобразяться порожні картографічне і табличне вікна 

новоствореного шару, а також картографічне вікно електронної карти 

України. 

14. Використовуючи менеджер шарів Layer Control, у картографічному вікні 

електронної карти України відмініть селекцію вибору окремих об'єктів 

шару політико-адміністративного поділу України на окремі райони. Для 

цього у стовпці Selectable навпроти шару електронної карти District зніміть 

відповідний прапорець. 

15. Використовуючи піктограму вибору окремих об'єктів шару політико-

адміністративного поділу України на окремі області, виділіть Волинську 

область та скопіюйте її у буфер обміну. Для цього використайте стандартні 

засоби роботи з об’єктами: команду головного меню Edit → Copy або 

комбінацію клавіш клавіатури Ctrl + C. 

16. Активуйте порожнє картографічне вікно новоствореного шару та 

використовуючи стандартні засоби роботи з об’єктами, вставте з буфера 

обміну скопійований об’єкт. Для цього використайте стандартні засоби 

роботи з об’єктами: команду головного меню Edit → Paste або комбінацію 

клавіш клавіатури Ctrl + V. 

17. Перевірте наявність статистичних даних для вставленого з буфера обміну 

скопійованого об’єкта. Для цього у табличному вікні новоствор еного шар у  

використайте повзунок прокрутки. 

18. За допомогою піктограми Save Table або відповідної команди головного 

меню File → Save Table… збережіть зміни у шарі електронної карти 

Пацюкевич_Volun.tab та закрийте його картографічне і табличне вікна. 

19. Використовуючи менеджер шарів Layer Control у картографічному вікні 

електронної карти України відмініть селекцію вибору окремих об'єктів у 

всіх шарах, окрім шару District. Для цього у стовпці Selectable навпроти 

назви шару електронної карти District залиште відповідний прапорець. 

20. Використовуючи піктограму New Table або команду головного меню File 

→ New Table… активуйте майстер  створення нового шару електронної 

карти. Для активації відкриття нових вікон типу Browser та Map 

новостворюваного шару електронної карти у діалоговому вікні New Table 

навпроти команд Open New Browser та Open New Mapper встановіть 

відповідні прапорці і натисніть кнопку Create... 
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21. У діалоговому вікні New Table Structure створіть структуру шару 

адміністративних районів Волинської області. Для цього  у 

функціональному блоці Field Information (Характеристика полів) 

встановіть параметри полів, зокрема у діалоговому рядку Name (Ім’я) 

введіть назву першого поля – Район, у випадаючому списку Туре (Тип) 

виберіть тип даних – Character (Символьний), а у діалоговому рядку 

Width (Ширина) встановіть кількість символів – 30 і натисніть кнопку 

Add Field (Додавання поля). Наступним полем новостворюваної таблиці є 

поле з іменем ID та типом даних – Small Integer (Цілочисельний 

скорочений), після створення якого натисніть кнопку Add Field. 

Аналогічно створіть поля з іменами Центр, Площа і Периметр та типами 

даних Character (кількість символів 30), Float і Float відповідно. 

22. У папці Мои документы \ Data \ Stud \  під іменем 

Пацюкевич_Volun_admin.tab збережіть новостворену структуру таблиці 

бази даних шару електронної карти. 

23. За допомогою команди головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. У робочій області 

програми відобразяться порожні картографічне і табличне вікна 

новоствореного шару, а також картографічне вікно електронної карти 

України. 

24. Використовуючи піктограму вибору окремих об'єктів шару політико-

адміністративного поділу України з поділом на райони, виділіть територію 

Шацького району та скопіюйте її у буфер обміну. Для цього використайте 

стандартні засоби роботи з об’єктами: команду головного меню Edit → Copy  

або комбінацію клавіш клавіатури Ctrl + C. 

25. Активуйте порожнє картографічне вікно новоствореного шару та 

використовуючи стандартні засоби роботи з об’єктами, вставте з буфера 

обміну скопійований об’єкт. Для цього використайте стандартні засоби  

роботи з об’єктами: команду головного меню Edit → Paste або комбінацію 

клавіш клавіатури Ctrl + V. Аналогічно скопіюйте решту 15 

адміністративних районів Волинської області.  

26. Перевірте наявність статистичних даних для кожного із 16 вставлених із 

буфера обміну скопійованих об’єктів. Для цього у табличному вікні 

новоствореного шару використайте повзунок прокрутки. Результат 

порівняйте зі зразком, що поданий на рис. 3.2. Для кожного 

адміністративного району Волинської області заповніть поле Центр 

картографічної бази даних. 

27. Використовуючи піктограму вибору об'єктів у картографічному вікні 

Пацюкевич_Volun_admin визначте площу і периметр кожного 

адміністративного району. Для цього наведіть маркер миші на відповідний 

географічний об'єкт та двічі натисніть ліву кнопку миші. Використовуючи 

взаємозв’язок між картографічним і табличним вікнами шару електронної 
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карти Пацюкевич_Volun_admin для кожного адміністративного району 

Волинської області заповніть поля Площа та Периметр картографічної 

бази даних. При цьому поле ID не заповнюється. 

 

Рис. 3.2. Картографічне і табличне вікна   

шару адміністративних районів Волинської області 

28. Для кожного адміністративного району Волинської області заповніть  поле 

Центр картографічної бази даних. 

29. Використовуючи піктограму вибору об'єктів, у картографічному вікні 

Пацюкевич_Volun_admin визначте площу і периметр кожного 

адміністративного району. Для цього наведіть маркер миші на відповідний 

географічний об'єкт та двічі натисніть ліву кнопку миші. Використовуючи 

взаємозв’язок між картографічним і табличним вікнами шару електронної 

карти Пацюкевич_Volun_admin для кожного адміністративного району 

Волинської області заповніть поля Площа та Периметр картографічної 

бази даних. При цьому поле ID не заповнюється. 

30. За допомогою піктограми Save Table або відповідної команди головного 

меню File → Save Table… збережіть зміни у шарі електронної карти 

Пацюкевич_Volun_admin.tab, після чого закрийте його картографічне і 

табличне вікна. 

31. Використовуючи менеджер шарів Layer Control у картографічному вікні 

електронної карти України відмініть вибір окремих об'єктів у всіх шарах, 

окрім шарів City та Town. Для цього у стовпці Selectable навпроти шарів 

електронної карти City та Town залиште відповідні прапорці. 

32. Використовуючи менеджер шарів Layer Control у картографічному вікні 

електронної карти України відмініть підписи 
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адміністративних районів. Для цього у стовпці Auto Label навпроти шару 

електронної карти District зніміть відповідний прапорець. 

33. Використовуючи менеджер шарів Layer Control виведіть підписи міст та 

селищ міського типу України із наступними параметрами: власна назва – 

поле Назва; шрифт підпису – Arial CYR; розмір кегля – 10; стиль – Bold 

та Shadow; колір – синій; відступ – 2 пт на схід від його центроїда (при 

цьому слід враховувати, що підписи населених пунктів зі зміною масштабу 

генералізуються). 

34. Використовуючи піктограму New Table або команду головного меню File 

→ New Table… активуйте майстер  створення нового шару електронної 

карти. Для активації відкриття нових вікон типу Browser та Map 

новостворюваного шару електронної карти у діалоговому вікні New Table 

навпроти команд Open New Browser та Open New Mapper встановіть 

відповідні прапорці і натисніть кнопку Create... 

35. У діалоговому вікні New Table Structure створіть структуру шару 

адміністративних районів Волинської області. Для цього у 

функціональному блоці Field Information (Характеристика полів) 

встановіть параметри полів, зокрема у діалоговому рядку Name (Ім’я) 

введіть назву першого поля – Назва, у випадаючому списку Туре (Тип) 

виберіть тип даних – Character (Символьний), а у діалоговому рядку 

Width (Ширина) встановіть кількість символів – 30 і натисніть кнопку 

Add Field (Додавання поля). 

36. У папці Мои документы \ Data \ Stud \  під іменем Пацюкевич_Volun_ 

town.tab. збережіть новостворену структуру таблиці бази даних шару 

електронної карти. 

37. За допомогою команди головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. У робочій області 

програми відобразяться порожні картографічне і табличне вікна 

новоствореного шару, а також картографічне вікно електронної карти 

України. 

38. Використовуючи піктограму вибору окремих об'єктів відкритих шарів 

населених пунктів України, виділіть територію населеного пункту Шацьк та 

скопіюйте її у буфер обміну. Для цього використайте стандартні засоби  

роботи з об’єктами: команду головного меню Edit → Copy  або комбінацію 

клавіш клавіатури Ctrl + C. 

39. Активуйте порожнє картографічне вікно новоствореного шару та 

використовуючи стандартні засоби роботи з об’єктами, вставте з буфера 

обміну скопійований об’єкт. Для цього використайте стандартні засоби  

роботи з об’єктами: команду головного меню Edit → Paste або комбінацію 

клавіш клавіатури Ctrl + V. Аналогічно скопіюйте решту 15 центрів 

адміністративних районів Волинської області. 

40. Перевірте наявність статистичних даних для кожного із 16 вставлених із 
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буфера обміну скопійованих об’єктів. Для цього у табличному вікні 

новоствореного шару використайте повзунок прокрутки. 

41. За допомогою піктограми Save Table або відповідної команди головного 

меню File → Save Table… збережіть зміни у шарі електронної карти 

Пацюкевич_Volun_town.tab. 

42. За допомогою команди головного меню File → Close All закрийте всі шари 

електронної карти. 

43. З папки Мои документы \ Data \ Stud завантажте шари новоствореної 

цифрової карти Волинської області: Пацюкевич_Volun.tab (контур 

області), Пацюкевич_Volun_admin.tab (контури районів) та 

Пацюкевич_Volun_town.tab (центри районів). 

44. Використовуючи менеджер шарів Layer Control розмістіть шари 

електронної карти Волинської області відповідно до поданого зразка (рис. 

3.3). 

 

Рис. 3.3. Розташування шарів електронної карти 

45. Використовуючи менеджер шарів Layer Control виведіть підписи центрів 

адміністративних районів Волинської області з наступними параметрами: 

власна назва – поле Назва; шрифт підпису – Arial CYR; розмір кегля –  12; 

стиль – Bold; колір – чорний; відступ – 5 пт на південний схід від його 

центроїда (при цьому слід враховувати, що підписи адміністративних 

районів зі зміною масштабу генералізуються). 

46. Використовуючи піктограму New Browser або команду головного меню 

Window → New Browser Window… відкрийте таблицю шару 

адміністративних районів Волинської області Пацюкевич_Volun_admin. 

47. Активуйте картографічне вікно новоствореної електронної карти політико-

адміністративного поділу Волинської області. 

48. Використовуючи стандартні засоби ГІС MapInfo Professional 5.0 

побудуйте додруковий макет електронної карти політико-

адміністративного поділу Волинської області зі стандартними 

параметрами. Побудова додрукового макету електронної карти 

здійснюється за допомогою команди головного меню Window → New 

Layout Window.  
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49. Встановіть параметри налаштування додрукового макету електронної 

карти: формат паперу – A4; орієнтування паперу – Landscape; поля – 10 

мм; кількість сторінок формату – 11 сторінка (по горизонталі і 

вертикалі). Налаштування параметрів друку електронної карти 

здійснюється за допомогою команди головного меню File →  Page Setup. 

Налаштування параметрів додрукового макету електронної карти 

здійснюється за допомогою команди головного меню Layout →  Options… 

50. Встановіть фіксований масштаб фрейму електронної карти. Для зміни 

масштабу у вікні додрукового макету Layout лівою кнопкою миші 

активуйте вікно параметрів фрейму Frame Object та у полі Scale on Paper 

встановіть значення іменованого масштабу в 1 см – 15 км (рис. 3.4). 

 

Рис. 3.4. Вікно встановлення параметрів фрейму 

51. Для зміни стилю фрейму у вікні додрукового макету карти Layout за 

допомогою команди головного меню Options → Region Style активуйте 

вікно зміни стилю площинного об’єкту та встановіть наступні параметри: у 

полі Pattern функціонального блоку Fill встановіть прозорий фон – None, а 

у полі Style функціонального блоку Border – відсутність контуру фрейму –  

None. 

52. Розмістіть фрейм електронної карти по лівому краю активної робочої 

області додрукового макету Layout. 

53. Використовуючи піктограму Frame панелі інструментів Drawing додайте 

таблицю атрибутивних даних шару політико-адміністративного поділу 

Волинської області на окремі райони – Пацюкевич_Volun_admin. 

54. Оформлення додрукового макету виконайте за зразком, що поданий на рис. 

3.5. 

55. У папку Мои документы \ Data \ Stud збережіть робочий простір під 

унікальним іменем (наприклад, Пацюкевич_GIS_3.wor, де Пацюкевич – 

прізвище студента, GIS – предмет, 3 – номер лабораторної роботи). 

56. Закрийте усі активні шари карти та програму MapInfo Professional 5.0. 
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Рис. 3.5. Приклад оформлення додрукового макету аудиторної роботи №  3 
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Завдання для самостійної роботи 

Використовуючи шари новоствореної цифрової карти Волинської області 

Пацюкевич_Volun.tab (контур області), Пацюкевич_Volun_admin.tab 

(контури районів) та Пацюкевич_Volun_town.tab (центри районів), шар 

поділу території на сільські, селищні та міські ради (Sub_District_Volun.tab) 

та шари населених пунктів України: City.tab, Town.tab, Village.tab засобами 

ГІС MapІnfo Professional 5.0 відповідно до запропонованого варіанту для 

певного адміністративного району створити: 1 – шар  району з полями Район, 

ID, Центр, Площа, Периметр; 2 – шар поділу району на сільські, селищні та 

міські ради з полями Назва, ID, Площа, Периметр; 3 – шар центрів сільських, 

селищних та міських рад з полем Назва та заповнити атрибутивними даними 

відповідні таблиці шарів. 

Використовуючи правила оформлення додрукового макету у ГІС MapІnfo 

Professional 5.0, сформувати документ із результатами виконання завдань 

самостійної роботи і оформити його відповідно до поданого зразка (рис. 3.6).  

 

Варіанти завдань для самостійної роботи 

№ варіантів Назви районів 

1 Володимир-Волинський 

2 Горохівський 

3 Іваничівський 

4 Камінь-Каширський 

5 Ківерцівський 

6 Ковельський 

7 Локачинський 

8 Луцький 

9 Любешівський 

10 Любомльський 

11 Маневицький 

12 Ратнівський 

13 Рожищенський 

14 Старовижівський 

15 Турійський 

16 Шацький 
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Рис.3.6. Приклад оформлення додрукового макету самостійної роботи № 3  
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Лабораторна робота № 4 

Тема: Укладання загальногеографічної карти регіону засобами ГІС MapInfo 

Professional 5.0 

Мета: навчитись створювати і формувати наповнення картографічної бази 

даних та укладати загальногеографічну карту р егіону засобами ГІС 

MapInfo Professional 5.0 

Інформаційне забезпечення: електронні шари цифрової карти України 

масштабу 1:500 000 (River.tab, Lake.tab, Channel.tab, Relief.tab, 

Region.tab, District.tab, City.tab, Town.tab, Village.tab, Forest.tab, 

Way.tab, Railway.tab); електронні шари цифрової карти Волинської 

області (Пацюкевич_Volun.tab, Пацюкевич_Volun_admin.tab, 

Пацюкевич_Volun_town.tab) 

Програмне забезпечення: географічна інформаційна система MapInfo 

Professional 5.0 

Звітні матеріали: файли картографічної бази даних регіону у фор маті .tab , 

електронні документи робочих просторів з результатами аудиторної і 

самостійної роботи та їх паперові аналоги 

Термін виконання: 4 год 

Порядок виконання роботи 

1. За допомогою стандартних засобів операційної системи: через меню Пуск, 

піктограмою на робочому столі або на панелі Быстрый запуск 

(Пуск → Программы → GIS → MapInfo → MapInfo  Professional 5.0) 

запустіть програму ГІС MapInfo Professional 5.0. На початку сеансу 

роботи з геоінформаційною системою MapInfo Professional 5.0 слід 

відмовитись від відкриття попередньої сесії роботи з програмою, робочого 

простору та окремого шару електронної карти. Для цього у  діалоговому 

вікні Start Up натисніть Cancel. 

2. З папки Мои документы \ Data \ Stud завантажте шари цифрової карти 

Волинської області: Пацюкевич_Volun.tab (контур області), 

Пацюкевич_Volun_admin.tab (контури районів) та 

Пацюкевич_Volun_town.tab (районні центри). 

3. Розташуйте по центру електронну карту Волинської області та 

використовуючи піктограми зміни масштабу відобразіть її відповідно до 

розмірів картографічного вікна Мар. 

4. Використовуючи менеджер шарів Layer Control відключіть функцію 

вибору шару Пацюкевич_Volun_admin. Для цього у стовпці Selectable 

навпроти шару електронної карти Пацюкевич_Volun_admin зніміть 

відповідний прапорець. 

5. Використовуючи менеджер шарів Layer Control виведіть підписи 

районних центрів Волинської області із наступними параметрами: власна 

назва – поле Назва; шрифт підпису – Arial CYR; розмір кегля – 12; стиль – 
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Bold; колір – чорний; відступ – 2 пт на південний схід від його центроїда 

(при цьому слід враховувати, що підписи адміністративних районів зі 

зміною масштабу генералізуються). 

6. З папки Мои документы \ Data \ Ukraine завантажте електронний шар 

цифрової карти України Lake.tab (озера України). 

7. Використовуючи піктограму вибору об’єктів одного шару в межах об’єкта 

іншого шару Boundary Select панелі інструментів Main виділіть та 

скопіюйте озера Волинської області у буфер обміну. Для цього 

використайте стандартні засоби роботи з об’єктами: команду головного меню 

Edit → Copy або комбінацію клавіш клавіатури Ctrl + C. 

8. Використовуючи піктограму створення нового шару New Table або 

команду головного меню File → New Table… активуйте майстер  

створення нового шару електронної карти. Для активації відкриття нових 

вікон типу Browser (Таблиця) та Map (Карта) новостворюваного шару 

електронної карти у діалоговому вікні New Table навпроти команд Open 

New Browser та Open New Mapper встановіть відповідні прапорці і 

натисніть кнопку Create... 

9. У діалоговому вікні New Table Structure відтворіть структуру шару озер 

України. Для цього у діалоговому рядку Name (Ім’я) функціонального 

блоку Field Information (Характеристика полів) вкажіть назву першого 

поля – Власна_назва, у випадаючому списку Туре (Тип) виберіть тип 

даних – Character (Символьний), а у діалоговому рядку Width (Ширина) 

встановіть максимальну кількість символів – 30. 

10. У папці Мои документы \ Data \ Stud \  під іменем 

Пацюкевич_Volun_Lake.tab збережіть новостворену структуру таблиці 

бази даних шару електронної карти. 

11. За допомогою команди головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. При цьому у 

робочій області програми відобразяться порожні картографічне і табличне 

вікна новоствореного шару, а також картографічне вікно електронної 

карти Волинської області. 

12. Активуйте порожнє картографічне вікно новоствореного шару та 

використовуючи стандартні засоби роботи з об’єктами, вставте з буфера 

обміну скопійовані об’єкти. Для цього використайте стандартні засоби  

роботи з об’єктами: команду головного меню Edit → Paste або комбінацію 

клавіш клавіатури Ctrl + V. 

13. Перевірте наявність статистичних даних для вставлених з буфера обміну 

скопійованих об’єктів. Для цього у табличному вікні новоствореного шару 

використайте повзунок прокрутки.  

14. За допомогою піктограми Save Table або відповідної команди головного 

меню File → Save Table… збережіть зміни у шарі електронної карти 

Пацюкевич_Volun_Lake.tab та закрийте його картографічне і табличне 
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вікна. 

15. За допомогою команди головного меню File → Close Table… закрийте 

електронний шар цифрової карти України Lake.tab (озера України). 

16. Використовуючи файли шарів цифрової карти України River.tab та 

Channel.tab з папки Мои документы \ Data \ Ukraine \ аналогічним чином 

створіть шари річок та каналів Волинської області з відповідними іменами 

файлів Пацюкевич_Volun_River.tab та Пацюкевич_Volun_Channel.tab. 

17. З папки Мои документы \ Data \ Stud завантажте шари цифрової карти 

Волинської області: Пацюкевич_Volun_River.tab (річки), 

Пацюкевич_Volun_Channel.tab (канали) та Пацюкевич_Volun_Lake.tab 

(озера). 

18. Розташуйте по центру електронну карту Волинської області та 

використовуючи піктограми зміни масштабу відобразіть її відповідно до 

розмірів картографічного вікна Мар. Результат порівняйте зі зразком, що 

подано на рис. 4.1. 

 
Рис. 4.1. Відображення шарів гідрографії та адміністративного поділу 

Волинської області 

19. Зауважте, що певна частина лінійних об’єктів гідрографії виходить за межі 

Волинської області. 

20. Використовуючи менеджер шарів Layer Control активуйте функцію 

редагування шару Пацюкевич_Volun_River. Для цього у стовпці Editable 

навпроти даного шару встановіть відповідний прапорець.  

21. Виділіть р. Західний Буг за межами Волинської області. Для цього 

використовуючи команду контекстного меню Edit Objects → Set Target 
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виконайте вибір об’єкту. Виділіть територію Волинської області і за 

допомогою команди контекстного меню програми Edit 

Objects → Erase Outside видаліть частину об’єкту р. Західний Буг за 

межами Волинської області із збереженням даних у таблиці (р ис. 4.2). 

Аналогічним чином видаліть частини інших об’єктів шару річок 

Пацюкевич_Volun_River, що знаходяться за межами Волинської області. 

За допомогою піктограми Save Table або відповідної команди головного 

меню File → Save Table… збережіть зміни у шарі 

Пацюкевич_Volun_River. 

 
Рис. 4.2. Вигляд вікна розбиття об’єкту Data Disaggregation  

22. Використовуючи менеджер шарів Layer Control активуйте функцію 

редагування шару Пацюкевич_Volun_Channel. Для цього у стовпці 

Editable навпроти даного шару встановіть відповідний прапорець. 

23. Виділіть канал за межами Волинської області. Для цього використовуючи 

команду контекстного меню Edit Objects → Set Target виконайте вибір 

об’єкту. Виділіть територію Волинської області і за допомогою команди 

контекстного меню програми Edit Objects → Erase Outside видаліть 

частину каналу за межами Волинської області із збереженням даних у 

таблиці. Аналогічним чином видаліть частини інших об’єктів шару каналів 

Пацюкевич_Volun_Channel, що знаходяться за межами Волинської 

області. За допомогою піктограми Save Table або відповідної команди 

головного меню File → Save Table… збережіть зміни у шарі 

Пацюкевич_Volun_Channel. 

24. Використовуючи файл шару цифрової карти України Relief.tab з папки 

Мои документы \ Data \ Ukraine \ аналогічним чином створіть шар рельєфу 

Волинської області з іменем файлу Пацюкевич_Volun_Relief.tab. 

25. З папки Мои документы \ Data \ Stud завантажте шар рельєфу цифрової 

карти Волинської області Пацюкевич_Volun_Relief.tab. 

26. Розташуйте по центру електронну карту Волинської області та 

використовуючи піктограми зміни масштабу відобразіть її відповідно до 

розмірів картографічного вікна Мар. Результат порівняйте зі зразком, що 
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подано на рис. 4.3. 

 

Рис. 4.3. Відображення шарів гідрографії, рельєфу  

та адміністративного поділу Волинської області 

27. Згорніть картографічне вікно Map електронної карти Волинської області. 

28. З папки Мои документы \ Data \ Stud у нове картографічне вікно 

завантажте електронні шари цифрової карти Волинської області: 

Пацюкевич_Volun.tab (контур області), Пацюкевич_Volun_admin.tab 

(контури районів) та Пацюкевич_Volun_town.tab (районні центри). Для 

цього при відкритті шару Пацюкевич_Volun.tab у випадаючому списку 

Preferred View вікна Open Table виберіть пункт New Mapper (рис. 4.4), а 

потім звичайним способом відкрийте інші шари. 

 
Рис. 4.4. Зразок відкриття шару у новому картографічному вікні  
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29. Розташуйте по центру електронну карту Волинської області та 

використовуючи піктограми зміни масштабу відобразіть її відповідно до 

розмірів картографічного вікна Мар. 

30. Використовуючи менеджер шарів Layer Control відключіть вибір шару 

Пацюкевич_Volun_admin. Для цього у стовпці Selectable навпроти даного 

шару зніміть відповідний прапорець. 

31. Використовуючи менеджер шарів Layer Control виведіть підписи 

районних центрів Волинської області із наступними параметрами: власна 

назва – поле Назва; шрифт підпису – Arial CYR; розмір кегля – 12; стиль – 

Bold; колір – чорний; відступ – 2 пт на південний схід від його центроїда 

(при цьому слід враховувати, що підписи адміністративних областей зі 

зміною масштабу генералізуються). 

32. Використовуючи файли шарів цифрової карти України Way.tab та 

Railway.tab з папки Мои документы \ Data \ Ukraine \ аналогічним чином 

створіть шари автомобільних та залізничних шляхів сполучення Волинської 

області з відповідними іменами файлів Пацюкевич_Volun_Way.tab та 

Пацюкевич_Volun_Railway.tab.  

33. З папки Мои документы \ Data \ Stud завантажте шари цифрової карти 

Волинської області Пацюкевич_Volun_Way.tab (автомобільні шляхи 

сполучення) та Пацюкевич_Volun_Railway.tab (залізничні шляхи 

сполучення). 

34. Використовуючи шар цифрової карти України Forest.tab з папки 

Мои документы \ Data \ Ukraine \ аналогічним чином створіть шар 

лісового покриву Волинської області з іменем файлу 

Пацюкевич_Volun_Forest.tab.  

35. З папки Мои документы \ Data \ Stud завантажте шар цифрової карти 

Волинської області Пацюкевич_Volun_Forest.tab (лісовий покрив).  

36. Розташуйте по центру електронну карту Волинської області та 

використовуючи піктограми зміни масштабу відобразіть її відповідно до 

розмірів картографічного вікна Мар. Результат порівняйте зі зразком, що 

подано на рис. 4.5. 

37. Розгорніть обидва картографічних вікна електронних шарів 

загальногеографічної карти і за допомогою команди Tile Windows… 

головного меню Window впорядкуйте їх. 

38. Використовуючи піктограму зміни масштабу карти Change View 

встановіть значення 1:1 500 000 для кожного з картографічних вікон. 

Зміна масштабу цифрової карти здійснюється за допомогою команди 

головного меню Map → Change View. Розмістіть цифрову карту 

Волинської області по центру картографічного  вікна Map. 

39. Використовуючи стандартні засоби ГІС MapInfo Professional 5.0 

побудуйте додруковий макет, що синтезує зображення двох 

загальногеографічних електронних карт Волинської області зі 
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стандартними параметрами. Побудова додрукового макету здійснюється  за 

допомогою команди головного меню Window → New Layout Window. У 

діалоговому вікні New Layout Window встановіть перемикач у положення 

Frames for All Currently Open Windows (рис. 4.6). 

 
Рис. 4.5. Відображення шарів шляхів сполучення, лісового покриву та 

адміністративного поділу Волинської області 

 
Рис. 4.6. Вигляд вікна нового додрукового макету New Layout Window  

40. Встановіть стандартні параметри налаштування додрукового макету 

електронної карти: формат паперу – A4; орієнтування паперу – Landscape; 

поля – 10 мм; кількість сторінок формату – 11 сторінка (по горизонталі і 

вертикалі). Налаштування параметрів друку електронної карти 

здійснюється за допомогою команди головного меню File →  Page Setup. 

Налаштування параметрів додрукового макету електронної карти 

здійснюється за допомогою команди головного меню Layout →  Options… 

41. Встановіть фіксований масштаб фреймів електронних карт. Для зміни 

масштабу у вікні додрукового макету Layout лівою кнопкою миші 

активуйте вікно параметрів фрейму Frame Object та у полі Scale on Paper 
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встановіть значення іменованого масштабу в 1 см – 15 км (рис.4.7). 

 

Рис. 4.7. Вигляд вікна параметрів фрейму Frame Object 

42. Для зміни стилю фрейму у вікні додрукового макету карти Layout за 

допомогою команди головного меню Options → Region Style активуйте 

вікно зміни стилю площинного об’єкту та встановіть наступні параметри: у 

полі Pattern функціонального блоку Fill встановіть прозорий фон – None, а 

у полі Style функціонального блоку Border – відсутність контуру фрейму –  

None. 

43. Оформлення додрукового макету виконайте за зразком, що поданий на рис. 

4.8. 

44. У папку Мои документы \ Data \ Stud збережіть робочий простір під 

унікальним іменем (наприклад, Пацюкевич_GIS_4.wor, де Пацюкевич – 

прізвище студента, GIS – назва предмета, 4 – номер лабораторної роботи). 

45. Закрийте усі активні шари карти та програму MapInfo Professional 5.0. 
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Рис.4.8. Приклад оформлення додрукового макету аудиторної роботи № 4 
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Завдання для самостійної роботи 

Використовуючи електронні шари новоствореної цифрової карти 

Волинської області Пацюкевич_Volun.tab (контур області), 

Пацюкевич_Volun_admin.tab (контури районів), Пацюкевич_Volun_town.tab 

(районні центри), шар поділу області на сільські, селищні та міські ради 

(Sub_District_Volun.tab) та електронні шари цифрової карти України масштабу 

1:500 000 (River.tab, Lake.tab, Channel.tab, Relief.tab, Region.tab, District.tab, 

City.tab, Town.tab, Village.tab, Forest.tab, Way.tab, Railway.tab ) засобами ГІС 

MapInfo Professional 5.0 відповідно до запропонованого варіанту для певного 

району створити макети загальногеографічних карт з шарами: 1 – 

адміністративного поділу, центрів сільських, селищних і міських рад, 

гідрографії та рельєфу; 2 – адміністративного поділу, центрів сільських, 

селищних та міських рад, шляхів сполучення та лісового покриву . 

Використовуючи правила оформлення додрукового макету у ГІС MapInfo 

Professional 5.0, сформувати документ із результатами виконання завдань 

самостійної роботи і оформити його відповідно до поданого зразка (рис. 4.9). 

Варіанти завдань для самостійної роботи 

№ варіантів Назви районів 

1 Володимир-Волинський 

2 Горохівський 

3 Іваничівський 

4 Камінь-Каширський 

5 Ківерцівський 

6 Ковельський 

7 Локачинський 

8 Луцький 

9 Любешівський 

10 Любомльський 

11 Маневицький 

12 Ратнівський 

13 Рожищенський 

14 Старовижівський 

15 Турійський 

16 Шацький 
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Рис. 4.9. Приклад оформлення додрукового макету самостійної роботи № 4  
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Лабораторна робота № 5 

Тема: Укладання тематичної карти засобами ГІС MapІnfo Professional 5.0  

(способи картограм і картодіаграм) 

Мета: навчитись створювати і укладати електронну тематичну карту регіону 

засобами ГІС MapІnfo Professional 5.0 шляхом комбінування 

способів картографічного зображення (картограм і картодіаграм) 

Інформаційне забезпечення: статистичні матеріали структури земельного 

фонду сільськогосподарських угідь Волинської області у розрізі її 

адміністративних одиниць (форма 6-зем); шари цифрової карти 

Волинської області (Пацюкевич_Volun.tab, 

Пацюкевич_Volun_admin.tab, Пацюкевич_Volun_town.tab)  

Програмне забезпечення: географічна інформаційна система Maplnfo 

Professional 5.0 

Звітні матеріали: файли картографічної бази даних Волинської області у 

форматі .tab, електронні документи робочих просторів з результатами 

аудиторної і самостійної роботи та їх паперові аналоги 

Термін виконання: 4 год 

Порядок виконання роботи 

1. За допомогою стандартних засобів операційної системи: через меню Пуск, 

піктограмою на робочому столі або на панелі Быстрый запуск 

(Пуск → Программы → GIS → MapІnfo → MapІnfo  Professional 5.0) 

запустіть програму ГІС MapInfo Professional 5.0. На початку сеансу 

роботи з геоінформаційною системою MapInfo Professional 5.0 слід 

відмовитись від відкриття попередньої сесії роботи з програмою, робочого 

простору та окремого шару електронної карти. Для цього у  діалоговому 

вікні Start Up натисніть Cancel. 

2. З папки Мои документы \ Data \ Stud завантажте електронні шари 

цифрової карти Волинської області: Пацюкевич_Volun.tab (контур 

області), Пацюкевич_Volun_admin.tab (контури районів) та 

Пацюкевич_Volun_town.tab (районні центри). 

3. Розташуйте по центру електронну карту Волинської області та 

використовуючи піктограми зміни масштабу відобразіть її відповідно до 

розмірів картографічного вікна Мар. 

4. Використовуючи менеджер шарів Layer Control виведіть підписи 

районних центрів Волинської області із наступними параметрами: власна 

назва – поле Назва; шрифт підпису – Arial CYR; розмір кегля – 12; стиль – 

Bold; колір – чорний; відступ – 2 пт на південний схід від його центроїда 

(при цьому слід враховувати, що підписи районних центрів зі зміною 

масштабу генералізуються). 
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5. Використовуючи команду головного меню Table → Maintenance… → 

Table Structure змініть структуру шару адміністративного поділу 

Волинської області на райони (Пацюкевич_Volun_admin.tab), 

доповнивши його новими полями типу Float з іменами Рілля, Пасовища, 

Сіножаті, Багаторічні_насадження, Всього та Показник (рис.5.1). 

 
Рис. 5.1. Вікно зміни структури таблиці атрибутивних даних  

Modify Table Structure 

6. Повторно завантажте електронний шар цифрової карти Волинської області 

Пацюкевич_Volun_admin.tab (контури районів). 

7. Використовуючи піктограму відкриття табличного вікна New Browser або 

команду головного меню Window → New Browser Window… відкрийте 

таблицю атрибутивних даних адміністративного поділу Волинської 

області на райони Пацюкевич_Volun_admin та розгорніть її на всю 

робочу область ГІС MapInfo Professional 5.0. 

8. Використовуючи статистичні матеріали структури земельного фонду 

сільськогосподарських угідь Волинської області у розрізі адміністративних 

районів (табл. 5.1) заповніть відповідні новостворені поля таблиці 

атрибутивних даних Пацюкевич_Volun_admin та збережіть її. 

9. Для автоматичного заповнення новоствореного поля Всього таблиці 

атрибутивних даних адміністративного поділу Волинської області 

Пацюкевич_Volun_admin сформуйте макрос визначення загальної площі 

сільськогосподарських угідь. Для цього слід використати команду 

головного меню Table → Update Column. У діалоговому вікні Update 

Column (рис. 5.2, а) встановіть наступні параметри: оновлення таблиці 

Table to Update – Пацюкевич_Volun_admin, оновлення поля Column to 

Update – Всього, використання даних з таблиці Get Value From Table – 

Пацюкевич_Volun_admin, а тоді для введення математичного виразу 

макросу натисніть кнопку Assist (рис. 5.2, б). Використовуючи назви полів 

таблиці атрибутивних даних адміністративного поділу Волинської області 

Пацюкевич_Volun_admin (вкладинка Columns) та оператори (вкладинка 
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Operators) діалогового вікна Expression введіть наступний вираз Рілля + 

Пасовища + Сіножаті + Багаторічні_насадження. Назви полів та 

операторів можна вводити також з клавіатури, однак в такому випадку 

необхідно дотримуватись ідентичності ідентифікаторів таблиці 

атрибутивних даних. У результаті виконання макросу агреговані дані 

автоматично будуть введені у поле Всього. Після цього необхідно 

зберегти зміни у таблиці. 

Таблиця 5.1 

Структура земельного фонду  

сільськогосподарських угідь Волинської області  

(з урахуванням площ територій міських рад)* 

№ 

з/п 
Назви районів  

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Володимир-Волинський 49290,5864 5954,6545 11321,9378 994,8555 

2 Горохівський 75284,3511 6422,7826 3673,9528 962,5148 

3 Іваничівський 39148,3522 4683,8281 3589,0549 978,5495 

4 Камінь-Каширський 33301,6820 13608,4877 13633,5351 558,2135 

5 Ківерцівський 41227,7827 10806,2940 13657,1397 1096,8553 

6 Ковельський 55178,2973 25169,1274 15049,5954 1040,0277 

7 Локачинський 43724,6000 6215,8800 1409,7000 447,2000 

8 Луцький 66306,7169 5686,2145 5158,9322 2730,3901 

9 Любешівський 23193,1588 13422,2538 10910,6403 202,8400 

10 Любомльський 33913,7340 18716,0314 15607,3846 370,0449 

11 Маневицький 37572,9688 20048,5356 15202,8032 399,5447 

12 Ратнівський 33843,3408 19715,1440 14867,4635 495,0497 

13 Рожищенський 47454,0499 13733,3280 10658,8814 508,7876 

14 Старовижівський 31558,6376 14996,6255 10874,0006 197,9000 

15 Турійський 50165,8865 19126,9225 10363,6900 558,4200 

16 Шацький 12066,2038 4225,7332 5261,6722 119,7900 

* за даними Головного управління Держземагенства у Волинській області 

10. Для автоматичного заповнення новоствореного поля Показник таблиці 

атрибутивних даних адміністративного поділу Волинської області 

Пацюкевич_Volun_admin сформуйте макрос визначення площ 

адміністративних районів. Для цього слід використати команду головного 

меню Table → Update Column. У діалоговому вікні Update Column (рис. 

5.3, а) встановіть наступні параметри: оновлення таблиці Table to Update – 

Пацюкевич_Volun_admin, оновлення поля Column to Update – 
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Показник, використання даних з таблиці Get Value From Table – 

Пацюкевич_Volun_admin, а тоді для введення математичного виразу 

макросу натисніть кнопку Assist (рис 5.3, б). Використовуючи функцію 

обчислення площі Area (вкладинка Functions) діалогового вікна 

Expression введіть наступний вираз: Area(obj, "sq km"), при цьому 

змініть одиниці виміру площі sq mi на sq km. За допомогою кнопки Verify 

перевірте синтаксис виразу. У результаті виконання макросу дані 

автоматично будуть введені у поле Показник. Після цього необхідно 

зберегти зміни у таблиці. 

 
Рис. 5.2, а, б. Формування макросу агрегування даних полів Рілля, 

Пасовища, Сіножаті і Багаторічні_насадження таблиці 

Пацюкевич_Volun_admin 

 

Рис. 5.3, а, б. Формування макросу визначення площ районів поля 

Показник таблиці Пацюкевич_Volun_admin 

11. Попарно порівняйте значення показників раніше створеного поля Площа 

та новоствореного поля Показник. При розбіжності значень за даними 

поля Показник внесіть виправлення у поле Площа і збережіть таблицю. 

12. Для автоматичного заповнення поля Показник таблиці атрибутивних 

даних адміністративного поділу Волинської області 

Пацюкевич_Volun_admin сформуйте макрос визначення показника 

сільськогосподарської освоєності території. Для цього  слід використати 
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команду головного меню Table → Update Column. У діалоговому вікні 

Update Column (рис. 5.4, а) встановіть наступні параметри: оновлення 

таблиці Table to Update – Пацюкевич_Volun_admin, оновлення поля 

Column to Update – Показник, використання даних з таблиці Get Value 

From Table – Пацюкевич_Volun_admin, після чого для введення 

математичного виразу макросу натисніть кнопку Assist (рис 5.4, б). 

Використовуючи назви полів таблиці атрибутивних даних 

адміністративного поділу Волинської області Пацюкевич_Volun_admin 

(вкладинка Columns) та оператори (вкладинка Operators) для отримання 

нормованого значення картографованого показника введіть наступний 

вираз (( Всього / 100 ) / Площа ) * 100. Назви полів та операторів можна 

вводити також з клавіатури. однак у такому випадку слід дотримуватись 

ідентичності ідентифікаторів таблиці атрибутивних даних. У результаті 

виконання макросу дані автоматично будуть введені у поле Показник. 

Після цього необхідно зберегти зміни у таблиці і закрити її вікно.  

 
Рис. 3.5.4. а. б. Формування макросу показника сільськогосподарської 

освоєності території поля Показник таблиці Пацюкевич_Volun_admin  

13. Для відображення на карті показників сільськогосподарської освоєності 

території Волинської області використайте спосіб картограм. Створення 

електронного шару тематичної карти здійснюється за допомогою команди 

головного меню Map → Create Thematic Map…, після чого активується 

майстер побудови тематичних карт. 

На першому кроці роботи майстру Step 1 of 3 у діалоговому вікні Create 

Thematic Map (рис. 5.5) встановіть наступні параметри побудови 

електронного шару тематичної карти: тип побудови тематичного шару 

Type – спосіб картограм Ranges, шаблон оформлення тематичних змінних 

Template Name – шкала картограм червоного кольору Region Ranges, Solid 

Red, Dark-Light. 

На другому кроці роботи майстру Step 2 of 3 у діалоговому вікні Create 

Thematic Map (рис. 5.6) встановіть наступні параметри побудови 

електронного шару тематичної карти: ім’я таблиці, за якою здійснюється 

побудова тематичного шару Table: – Пацюкевич_Volun_admin, назва 
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поля тематичної змінної Field: – Показник. 

 
Рис. 5.5. Вікно першого кроку роботи майстру побудови тематичних карт 

способом картограм Create Thematic Map - Step 1 of 3 

 
Рис. 5.6. Вікно другого кроку роботи майстру побудови тематичних карт 

способом картограм Create Thematic Map - Step 2 of 3 

На третьому кроці роботи майстру Step 3 of 3 у діалоговому вікні Create 

Thematic Map здійсніть остаточне оформлення шкали картограм та легенди 

тематичної карти. Для цього після натискання кнопки Ranges… встановіть 

наступні параметри побудови шкали картограм: метод побудови Method: –

довільні інтервали Custom, кількість інтервалів # of Ranges – 5. точність 

встановлення інтервалів Round By: – 0.1. Після цього у відповідні поля 

функціонального блоку Custom Ranges діалогового вікна Customize Ranges 

(рис. 5.7) введіть екстремальні значення кожного інтервалу і натисніть 

кнопки Recalc та Ok. Після натискання кнопки Styles… змініть параметри 

налаштування стилю оформлення шкали картограм (рис. 5.8) наступним 

чином: для інтервалу 28 – 38 встановіть світло-коричневий колір (у палітр і 

кольорів перший під червоним кольором). а для інтервалу значень 68  –  79 –  

темно-коричневий колір (у палітрі кольорів дев’ятий під червоним 

кольором) і натисніть кнопку Ok. Після натискання кнопки Legend… 

змініть налаштування параметрів оформлення легенди (рис. 5.9) наступним 

чином: основний підпис Title: – Сільськогосподарська освоєність; 

додатковий підпис Subtitle: – території, %; розміщення легенди Into 
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Window – нове вікно легенди New Legend Window; підписи меж інтер валів 

шкали картограм: 68 to 79 – понад 68, 58 to 68 – 58 – 68, 48 to 58 – 48 – 58, 38 

to 48 – 38 – 48, 28 to 38 – менше 38; відображення кількості елементів 

статистичного ряду у межах кожного інтервалу шкали картограм Show 

Record Count – відсутня; шрифт – Arial CYR; розмір кегля – 12; колір – 

чорний для основного Title Font і додаткового Subtitle Font підписів 

легенди та підписів інтервалів шкали картограм Font і натисніть кнопку Ok. 

Результат виконаних дій відобразиться у діалоговому вікні Create Thematic 

Map – Step 3 of 3 (рис. 5.10). Після завершення побудови електронного 

шару тематичної карти натисніть кнопку Ok. 

 
Рис. 5.7. Вікно третього кроку роботи майстру побудови тематичних карт 

способом картограм Create Thematic Map - Step 3 of 3 (Customize Ranges) 

 
Рис. 5.8. Вікно третього кроку роботи майстру побудови тематичних карт 

способом картограм Create Thematic Map - Step 3 of 3 (Customize Range 

Styles) 
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Рис. 5.9. Вікно третього кроку роботи майстру побудови тематичних карт 

способом картограм Create Thematic Map - Step 3 of 3 (Customize Legend) 

 
Рис. 5.10. Вікно третього кроку роботи майстру  побудови тематичних 

карт способом картограм Create Thematic Map - Step 3 of 3 

14. Використовуючи команду головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. У робочій області 

програми відобразяться вікна електронного шару тематичної карти і 

легенди тематичної карти. 

15. Використовуючи піктограму зміни масштабу електронної карти Change 

View встановіть значення числового масштабу 1:1 500 000. Зміна 

масштабу цифрової карти здійснюється за допомогою команди головного 

меню Map → Change View. Розмістіть цифрову карту Волинської області 

по центру картографічного вікна Map. Оптимізуйте розміри вікна легенди 

тематичної карти. Результат роботи порівняйте зі зразком, що поданий на 

рис.5.11. 
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Рис. 5.11. Вікна електронного шару тематичної карти і легенди 

тематичної карти (спосіб картограм) 

16. Активуйте картографічне вікно. 

17. Для відображення структури земельного фонду сільськогосподарських 

угідь Волинської області використайте спосіб картодіаграм у 

найпростішому варіанті – градуйовані стовпці. Створення електронного 

шару тематичної карти здійснюється за допомогою команди головного 

меню Map → Create Thematic Map…, після чого активується майстер 

побудови тематичних карт. 

На першому кроці роботи майстру Step 1 of 3 у діалоговому вікні Create 

Thematic Map (рис. 5.12) встановіть наступні параметри побудови 

електронного шару тематичної карти: тип побудови Type – спосіб 

картодіаграм Bar Charts; шаблон оформлення тематичних змінних 

Template Name – кольоровий Bar Chart Default.  

На другому кроці роботи майстру Step 2 of 3 у діалоговому вікні Create 

Thematic Map (рис. 5.13) встановіть наступні параметри побудови: ім’я 

таблиці, за якою здійснюється побудова тематичного шару Table: – 

Пацюкевич_Volun_admin, поля тематичних змінних. що 

використовуються при побудові картодіаграми Fields for Pie/Bar Chart: – 

Рілля, Пасовища, Сіножаті та Багаторічні_насадження. Додавання або 

вилучення полів тематичних змінних. що використовуються при побудові 

картодіаграми здійснюється за допомогою команд Add >> або << Remove. 

а зміна порядку їх розміщення – за допомогою команд Up та Down. 
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Рис. 5.12. Вікно першого кроку роботи майстру побудови тематичних карт 

способом картодіаграм Create Thematic Map - Step 1 of 3 

 
Рис. 5.13. Вікно другого кроку роботи майстру побудови тематичних карт 

способом картодіаграм Create Thematic Map - Step 2 of 3 

На третьому кроці роботи майстру Step 3 of 3 у діалоговому вікні Create 

Thematic Map здійсніть остаточне оформлення фігур картодіаграм та 

легенди тематичної карти. Для цього після натискання кнопки Styles… 

змініть параметри налаштування стилю оформлення (рис. 5.14) наступним 

чином: встановіть кольори для тематичних змінних Рілля – жовтий, 

Пасовища – блакитний, Сіножаті – зелений, Багаторічні_насадження – 

темно-зелений; максимальна висота стовпця Height – 2 см (для 

максимального значення тематичної змінної at value – 76000), ширина 

стовпця Width – 1.5 см. Після цього натисніть кнопку Ok. Після натискання 

кнопки Legend… змініть налаштування параметрів оформлення легенди 

(рис. 5.15) наступним чином: основний підпис Title: – Структура; 

додатковий підпис Subtitle: – сільськогосподарських угідь, га; розміщення 

легенди Into Window – нове вікно легенди New Legend Window; підписи 

тематичних змінних: Рілля – рілля, Пасовища – пасовища, Сіножаті 
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– сіножаті, Багаторічні_насадження – багаторічні насадження; шр ифт –  

Arial CYR; розмір кегля – 12; колір – чорний (для основного Title Font, 

додаткового Subtitle Font підписів легенди та підписів назв тематичних 

змінних Font) і натисніть кнопку Ok.  

 

Рис. 5.14. Вікно третього кроку роботи майстру побудови тематичних 

карт способом картодіаграм Create Thematic Map - Step 3 of 3 

(Customize Bar Styles) 

 

Рис. 5.15. Вікно третього кроку роботи майстру побудови тематичних 

карт способом картодіаграм Create Thematic Map - Step 3 of 3 

(Customize Legend) 

Результат виконаних дій відобразиться у діалоговому вікні Create Thematic 

Map – Step 3 of 3 (рис. 5.16). Після завершення побудови електронного 

шару тематичної карти натисніть кнопку Ok. 
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Рис.5.16. Вікно третього кроку роботи майстру побудови тематичних 

карт способом картограм Create Thematic Map - Step 3 of 3 

18. Використовуючи команду головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. У робочій області 

програми відобразяться вікно електронних шарів тематичної карти і два 

вікна легенд тематичної карти. 

19. Використовуючи піктограму зміни масштабу електронної карти Change 

View встановіть значення числового масштабу 1:1 500 000. Зміна 

масштабу цифрової карти здійснюється за допомогою команди головного 

меню Map → Change View. Розмістіть цифрову карту Волинської області 

по центру картографічного вікна Map. Оптимізуйте розміри вікон легенд 

тематичної карти. Результат роботи порівняйте зі зразком, що поданий на 

рис. 5.17. 

20. Активуйте картографічне вікно новоствореної тематичної карти та 

використовуючи стандартні засоби роботи з об’єктами продублюйте його. 

Для цього використайте стандартні засоби роботи з об’єктами: команди 

головного меню Edit → Copy та Edit → Paste або комбінацію клавіш 

клавіатури Ctrl + С та Ctrl + V. 

21. Використовуючи менеджер шарів Layer Control у скопійованому вікні 

тематичної карти за допомогою команди Remove видаліть тематичний шар 

Bars with Рілля.Пасовища.Сіно… (рис. 5.18). При цьому робочий простір  

не зберігайте. 

22. Для відображення структури земельного фонду сільськогосподарських 

угідь Волинської області використайте інший варіант способу картодіаграм 

– кругові структурні діаграми. Створення електронного шару тематичної 

карти здійснюється за допомогою команди головного меню Map → Create 

Thematic Map…, після чого активується майстер побудови тематичних 

карт.  
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Рис. 5.17. Вікна електронних шарів тематичної карти і легенд 

тематичної карти (спосіб картограм і картодіаграм (стовпці)) 

 
Рис. 5.18. Вікно менеджера шарів тематичної карти Layer Control 

На першому кроці роботи майстру Step 1 of 3 у діалоговому вікні Create 

Thematic Map (рис. 5.19) встановіть наступні параметри побудови 

електронного шару тематичної карти: тип побудови тематичного шару 

Type – спосіб картодіаграм Pie Charts; шаблон оформлення тематичних 

змінних Template Name – кольоровий Pie Chart Default.  

На другому кроці роботи майстру Step 2 of 3 у діалоговому вікні Create 

Thematic Map (рис.5.20) встановіть наступні параметри: ім’я таблиці, за 

якою здійснюється побудова тематичного шару Table: – 

Пацюкевич_Volun_admin, поля тематичних змінних. що 

використовуються при побудові картодіаграми Fields for Pie/Bar Chart: – 

Рілля, Пасовища, Сіножаті та Багаторічні_насадження. 
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Рис. 5.19. Вікно першого кроку роботи майстру побудови тематичних карт 

способом картодіаграм Create Thematic Map - Step 1 of 3 (кругові діаграми) 

 
Рис. 5.20. Вікно другого кроку роботи майстру побудови тематичних карт 

способом картодіаграм Create Thematic Map - Step 2 of 3 

На третьому кроці роботи майстру Step 3 of 3 у діалоговому вікні Create 

Thematic Map здійсніть остаточне оформлення фігур картодіаграм та 

легенди тематичної карти. Для цього після натискання кнопки Styles… 

змініть параметри налаштування стилю оформлення (рис. 5.21) наступним 

чином: встановіть кольори для тематичних змінних Рілля – жовтий, 

Пасовища – блакитний, Сіножаті – зелений, Багаторічні_насадження – 

темно-зелений; максимальний діаметр круга Diameter – 1.5 см (для 

максимального значення суми тематичних змінних  for sum – 100 000) і 

натисніть кнопку Ok. Після натискання кнопки Legend… змініть 

налаштування параметрів оформлення легенди (рис. 5.22) наступним чином: 

основний підпис Title: – Структура; додатковий підпис Subtitle: – 

сільськогосподарських угідь, га; розміщення легенди Into Window  –  нове 

вікно легенди New Legend Window; підписи тематичних змінних: Рілля – 

рілля, Пасовища – пасовища, Сіножаті – сіножаті, Багаторічні_на-
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садження – багаторічні насадження; шрифт – Arial CYR; розмір кегля – 

12; колір – чорний (для основного Title Font, додаткового Subtitle Font 

підписів легенди та підписів назв тематичних змінних  Font) і натисніть 

кнопку Ok.  

 
Рис. 5.21. Вікно третього кроку роботи майстру побудови тематичних 

карт способом картодіаграм Create Thematic Map - Step 3 of 3 

(Customize Pie Styles) 

 
Рис.5.22. Вікно третього кроку роботи майстру побудови тематичних карт 

способом картодіаграм Create Thematic Map - Step 3 of 3  

(Customize Legend) 

Результат виконаних дій відобразиться у діалоговому вікні Create Thematic 

Map – Step 3 of 3 (рис. 5.23). Після завершення побудови електронного 

шару тематичної карти натисніть кнопку Ok. 

23. Використовуючи команду головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. У робочій області 

програми відобразяться два вікна електронних  шарів тематичної карти і 

три вікна легенд тематичних карт. 
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Рис. 3.5.23. Вікно третього кроку роботи майстру побудови тематичних 

карт способом картограм Create Thematic Map - Step 3 of 3 (кругові 

діаграми) 

24. Використовуючи піктограму зміни масштабу електронної карти Change 

View у кожному з двох картографічних вікон встановіть значення 

числового масштабу 1:1 500 000. Зміна масштабу цифрової карти 

здійснюється за допомогою команди головного меню Map → Change 

View. Оптимізуйте розміри картографічних вікон і вікон легенд 

тематичних карт. Результат роботи порівняйте зі зразком, що поданий на 

рис. 5.24. 

 

Рис. 5.24. Вигляд картографічних вікон і вікон легенд  

тематичних карт 
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25. Використовуючи стандартні засоби ГІС MapInfo Professional 5.0 

побудуйте додруковий макет новостворених тематичних карт Волинської 

області зі стандартними параметрами. Побудова додрукового макету 

електронної карти здійснюється за допомогою команди головного меню 

Window → New Layout Window. У діалоговому вікні New Layout Window 

встановіть перемикач у положення Frames for All Currently Open 

Windows (рис. 5.25). 

 
Рис.5.25. Вікно відкриття додрукового макету New Layout Window  

26. Встановіть параметри налаштування додрукового макету тематичних кар т: 

формат паперу – A4; орієнтування паперу – Landscape; поля – 10 мм; 

кількість сторінок формату – 11 сторінка (по горизонталі і вертикалі). 

Налаштування параметрів друку електронної карти здійснюється за 

допомогою команди головного меню File →  Page Setup. Налаштування 

параметрів додрукового макету електронної карти здійснюється за 

допомогою команди головного меню Layout →  Options… 

27. Встановіть фіксований масштаб фреймів електронних карт. Для зміни 

масштабу у вікні додрукового макету Layout лівою кнопкою миші 

активуйте вікно параметрів фрейму Frame Object та у полі Scale on Paper 

встановіть значення іменованого масштабу в 1 см – 15 км (рис. 3.5.26). 

 
Рис. 5.26. Вікно встановлення параметрів фрейму Frame Object 

28. Для зміни стилю фрейму у вікні додрукового макету карти Layout 

командою головного меню Options → Region Style активуйте вікно зміни 

стилю площинного об’єкту та встановіть наступні параметри: у полі 

Pattern функціонального блоку Fill встановіть прозорий фон – None. а у 

полі Style функціонального блоку Border – відсутність контуру фрейму – 

None. 
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29. Оформлення додрукового макету виконайте за зразком. що поданий на рис. 

5.27. 

30. У папку Мои документы \ Data \ Stud збережіть робочий простір під 

унікальним іменем (наприклад. Пацюкевич_GIS_5.wor. де Пацюкевич – 

прізвище студента. GIS – предмет. 5 – номер лабораторної роботи). 

31. Закрийте усі активні шари тематичної карти та програму MapInfo 

Professional 5.0. 
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Рис. 5.27. Приклад оформлення додрукового макету аудиторної роботи №  5 
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Завдання для самостійної роботи 

Відповідно до запропонованого варіанту для певного адміністративного 

району використовуючи статистичні матеріали структури земельного фонду 

сільськогосподарських угідь Волинської області у розрізі сільських, селищних 

та міських рад засобами ГІС MapInfo Professional 5.0: 1 – змініть структуру 

шару адміністративного поділу району, доповнивши її новими полями типу 

Float з іменами Рілля, Пасовища, Сіножаті, Багаторічні_насадження, 

Всього та Показник і заповніть таблицю атрибутивних даних показниками 

площ ріллі, пасовищ, сіножатей та багаторічних насаджень; 2 – визначте 

загальну площу сільськогосподарських угідь у полі Всього для кожної 

територіальної одиниці району; 3 – розрахуйте показник сільськогосподарської 

освоєності території для кожної територіальної одиниці району у полі 

Показник; 4 – створіть макет карти з тематичними шарами показників 

сільськогосподарської освоєності території району (спосіб картограм), 

структури земельного фонду сільськогосподарських угідь  району (спосіб 

картодіаграм – градуйовані стовпці) та шару центрів сільських, селищних та 

міських рад; 5 – створіть макет карти з тематичними шарами показників 

сільськогосподарської освоєності території району (спосіб картограм), 

структури земельного фонду сільськогосподарських угідь  району (спосіб 

картодіаграм – кругові структурні діаграми) та шару центрів сільських, 

селищних та міських рад. 

Використовуючи правила оформлення додрукового макету у ГІС MapInfo 

Professional 5.0, сформувати документ із результатами виконання завдань 

самостійної роботи і оформити його відповідно до поданого зразка (рис. 5.28).  
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Рис. 5.28. Приклад оформлення додрукового макету самостійної роботи № 5 



 73 

Варіанти завдань для самостійної роботи 

Варіант № 1. Володимир-Волинський район 

№ 

з/п 
Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 
насадження 

1 Березовицька 4006,3084 165,2858 421,2370 27,0000 

2 Білинська 2971,9503 500,3178 537,6237 22,0000 

3 Бубнівська 2042,1470 115,8700 521,1023 24,7000 

4 Галинівська 1933,6700 21,4602 682,9026 19,6800 

5 Зарічанська 4215,1164 490,9698 522,1502 38,0000 

6 Зимневська 2099,2264 112,2775 556,7286 110,9960 

7 Зорянська 1696,4625 352,3474 593,5036 13,0000 

8 Красноставська 1740,1600 250,3079 308,8047 29,0000 

9 Ласківська 1484,5085 86,4361 145,1931 32,2000 

10 Лудинська 2229,2100 292,2576 673,9979 25,0000 

11 Льотничівська 2971,9464 131,8550 749,1205 37,2000 

12 Микитичівська 2134,5900 673,6814 1526,4568 8,0000 

13 Оваднівська 3229,8140 680,5610 731,5590 191,7200 

14 П'ятиднівська 1572,4718 118,9722 220,4198 37,7769 

15 Рогожанська 1605,7244 84,3939 174,6299 3,0000 

16 Селецька 1614,3496 125,1558 307,0300 31,6100 

17 Стенжаричівська 2202,4900 1306,0565 1145,2415 137,3000 

18 Хмелівківська 2965,8716 17,0911 365,4387 36,5000 

19 Хобултівська 2846,7499 132,0000 429,6615 7,4000 

20 Хотячівська 1613,2150 11,6957 178,6666 35,2900 

21 м Устилуг 1976,4157 285,6618 530,4698 127,4826 

22 м Володимир-Волинський 138,1885    
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Варіант № 2. Горохівський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 
насадження 

1 Бережанська 1515,4800 22,0000 30,9195 15,0000 

2 Бранівська 2919,0700 259,2297 143,5300 67,5100 

3 Бужанівська 1908,7100 84,5200 231,5500 46,5700 

4 Ватинська 1149,3000 39,3588  21,4000 

5 Вільхівська 2184,0778 177,6376 3,5873 9,3415 

6 Галичанська 1852,2000 301,0000 172,3000 10,0000 

7 Горішнянська 1658,1636 413,8364 225,6000 10,2000 

8 Губинська Перша 1697,0700 48,1100 21,0000 7,8000 

9 Жабченська 1608,9000 87,1000 78,4000 7,8000 

10 Журавниківська 1561,8614 57,0000 23,0000 17,6100 

11 Звиняченська 2856,1607 332,8393 317,9000 12,0000 

12 Квасівська 2269,0922 347,7078 0,2000 11,0000 

13 Колодеженська 2318,6600 439,0000 94,9400 13,6000 

14 Лемешівська 1303,0000 27,0000   20,0000 

15 Лобачівська 1779,0000 186,0260 291,3800 24,6000 

16 Мервинська 2511,3404 484,0000 54,0000 131,0000 

17 Мирківська 1454,7000 9,5000 141,9000 14,3000 

18 Мирненська 2885,2978 131,7022 27,0000 34,6500 

19 Михлинська 1376,5600 154,0000 74,0200 13,3000 

20 Новосілківська 2456,2653 442,5527 254,0000 7,0600 

21 Перемильська 2851,7373 153,7427 7,0000 75,9000 

22 Печихвостівська 3284,9933 252,8067 62,5000 29,4000 

23 Підбереззівська 1720,0078 57,6422 116,7600 47,9500 

24 Пірванченська 1808,6900 114,4000 160,9100 10,0000 

25 Пісківська 1524,0281 13,3000 49,7000 16,2000 

26 Пустомитівська 2204,2700 285,2400  14,0600 

27 Рачинська 2432,2459 66,1471 20,0000 24,3500 

28 Скірченська 1808,6377 105,0623  12,3000 

29 Скобелківська 3356,6500 68,1400 115,8600 52,5600 

30 Скриговська 1048,1900 17,0000 440,3100 4,9000 

31 Смолявська 2024,4149 368,2904 17,6800 6,3909 

32 Терешківцівська 1640,3600 89,2564 5,0000 3,4100 

33 Угринівська 1744,1457 168,1543 14,0000 19,0000 

34 Холонівська 1292,1915 241,8000 313,7000 45,5124 

35 Цегівська 5373,5670 153,1000 102,6360 67,5400 

36 Шклиньська 1511,2100 212,6200 54,6700 3,0000 

37 смт Мар'янівка 89,0000    

38 смт Сенкевичівка 149,0000 2,9600  14,0000 

39 м Берестечко 60,0000 9,0000 8,0000 4,1000 

40 м Горохів 96,1027    
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Варіант № 3. Іваничівський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Бужанська 1886,6899 661,7999 26,9000 54,5141 

2 Грибовицька 1321,1004 140,0706   12,9700 

3 Грядівська 2590,4500 357,3678 52,3000 45,7458 

4 Жашковичівська 1028,8702 25,1000 22,4000 4,1000 

5 Заболотцівська 2166,3847 267,4105 232,6100 61,4000 

6 Завидівська 1058,5918 144,4445 166,6161 15,7500 

7 Заставненська 1577,1720 346,5769 207,8000 23,7000 

8 Колонська 1511,1755 24,6762 15,3000 5,1000 

9 Литовезька 2005,7613 169,6010 255,2608 21,9412 

10 Луковичівська 2645,0190 237,9656 158,6322 17,0523 

11 Милятинська 1208,6444 213,5358 153,0000 20,0000 

12 Мишівська 2792,9612 174,2500 254,2898 36,3353 

13 Мовниківська 985,0496 501,1897 220,2617 10,0000 

14 Морозовичівська 887,0205 178,9300 18,6600 3,2000 

15 Павлівська 1801,3230 79,7561 355,6224 13,4337 

16 Переславичівська 881,1806 83,8498 301,6858 32,1000 

17 Поромівська 2400,0297 357,5916 247,3415 48,8800 

18 Радовичівська 1160,8193 91,0000 84,5187 4,8000 

19 Риковичівська 1854,6709 86,0355 141,5332 3,2000 

20 Соснинська 1644,4000 40,1630 113,9253 12,0000 

21 Старолішнянська 1535,0962 209,5024 56,8092 31,4224 

22 Старопорицька 1189,1022 211,0881 51,8900 7,6000 

23 Тополищенська 1058,0900 1,7835 180,4392 3,2000 

24 смт Іваничі 1837,9148 80,1396 271,2590 40,8547 

25 м Нововолинськ 120,8350   449,2500 
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Варіант № 4. Камінь-Каширський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Боровненська 426,6649 338,0000 801,2743 18,5000 

2 Броницька 1347,4334 547,5818 327,0514 16,3706 

3 Бузаківська 686,8260 127,5163 500,5000 23,0000 

4 Великообзирська 764,0864 415,7801 479,5000 4,0000 

5 Верхівська 736,2871 112,4599 72,8000 4,0000 

6 Видертська 1658,5646 425,1474 890,4344 24,0000 

7 Видричівська 1103,6682 550,1507 370,4000 19,0000 

8 Воєгощанська 1261,5984 234,0100 342,4300 38,4500 

9 Ворокомлівська 1679,1363 723,1645 424,0517 43,4500 

10 Грудківська 766,4204 282,7341 423,1904 4,0000 

11 Гута-Боровенська 755,3000 327,8963 508,4000 13,0000 

12 Добренська 781,2359 263,9830 231,9000 9,0000 

13 Залісська 630,7138 139,8293 416,0600 13,0000 

14 Карасинська 732,8414 450,2287 392,1950 8,0576 

15 Качинська 1222,6595 711,2024 704,0354 21,7000 

16 Клітицька 881,3780 388,4400 303,9200 12,0000 

17 Личинівська 824,9774 501,4000 192,7200 7,0000 

18 Мельнико-Мостищенська 479,3660 399,1126 106,5500 8,0000 

19 Новочервищанська 822,8321 381,4400 713,1000 6,0000 

20 Нуйнівська 1166,0926 629,3033 333,3000 10,0700 

21 Олениненська 466,3782 247,3817 67,9000 9,0000 

22 Осівецька 613,5028 342,1000 325,9862 9,0000 

23 Піщанська 656,1200 177,6746 231,9474 12,0000 

24 Пнівненська 2485,3786 945,9964 692,4000 23,0000 

25 Полицівська 1102,9159 346,3328 442,1000 5,0000 

26 Раково-Ліська 1483,1539 992,6024 425,9674 28,1290 

27 Сошичненська 1344,3973 297,5200 313,8557 25,0000 

28 Стобихівська 627,9412 319,4792 450,9409 13,0000 

29 Тобольська 834,5859 494,6028 431,4300 2,0000 

30 Хотешівська 1223,8938 844,0413 411,9000 47,2000 

31 Черченська 1520,7892 261,7867 973,8000 11,0000 

32 м Камінь-Каширський 2214,5428 389,5894 331,4949 71,2863 
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Варіант № 5. Ківерцівський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Берестянська 882,8605 141,1805 290,0000 15,1000 

2 Борохівська 1427,3750 522,9942 418,1000 149,5000 

3 Грем'яченська 1375,0544 216,0005 323,0414 22,9000 

4 Дернівська 2488,2436 1262,9888 584,6874 37,0000 

5 Дідичівська 2746,8049 82,4700 314,8500 25,2200 

6 Дубищенська 958,1802 132,5500 49,5366 32,1000 

7 Жидичинська 1323,6089 525,9271 376,1101 60,0864 

8 Жорнищенська 2582,4560 197,6923 223,3937 21,6000 

9 Журавичівська 1818,5344 756,2538 1111,1200 19,4000 

10 Завітненська 1463,2942 444,8922 579,8500 30,7000 

11 Звірівська 1304,4229 296,7581 540,2522 167,8000 

12 Карпилівська 600,1274 281,3690 75,7920 25,4000 

13 Липненська 1445,6314 698,9619 667,8190 35,1000 

14 Макаревичівська 1124,3556 491,1104 542,7800 17,3000 

15 Озерська 1164,6900 585,2900 668,3100 20,3000 

16 Озерцівська 822,2168 170,4814 414,3685 46,1300 

17 Покащівська 1180,5600 368,3300 360,3900 30,9300 

18 Прилуцька 1531,9708 145,9432 58,2446 76,3000 

19 Сильненська 1804,7700 569,0188 664,1328 13,5000 

20 Сокиричівська 1833,9039 456,4840 986,4100 46,8000 

21 Суська 2198,9517 424,1838 1447,6500 43,0000 

22 Тростянецька 1921,6384 737,2879 1293,2100 45,2900 

23 Холоневичівська 1223,0384 530,9485 636,8392 35,2000 

24 Хорлупівська 2355,8095 333,8300 222,6243 17,6000 

25 смт Олика 3098,1513 273,4682 457,3285 45,0000 

26 смт Цумань 500,2742 136,6692 93,6010 11,1200 

27 м Ківерці 50,8583 23,2102 256,6984 6,4789 
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Варіант № 6. Ковельський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Білашівська 2262,4100 1140,8400 244,6000 1,2000 

2 Білинська 1332,7610 689,2650 461,8218 13,2100 

3 Велицька 1904,9800 907,4900 170,0712 16,1000 

4 Городищенська 1334,7616 511,8500 558,1599 7,7000 

5 Доротищенська 1065,0818 460,5135 317,1679 8,9200 

6 Дрозднівська 2211,7431 1009,4100 826,7969 12,9200 

7 Дубовська 1159,7981 759,8895 422,9252 3,5557 

8 Зеленська 1074,7426 370,4153 90,6103 11,2700 

9 Козлиничівська 2361,4700 1313,2957 768,3223 18,5600 

10 Колодяжненська 1659,9800 926,3603 655,8900 81,8700 

11 Кричевичівська 2238,5527 751,5900 785,8500 14,0700 

12 Любитівська 3053,3078 747,8893 851,4800 28,2700 

13 Майданська 1302,6000 749,8000 239,3000 35,5000 

14 Мельницька 2326,1600 1204,0700 843,6400 29,7900 

15 Мощенська 1462,1590 811,5898 393,7527 12,2300 

16 Новомосирська 1592,7016 638,6990 942,5000 21,8000 

17 Облапська 1831,6721 559,4620 432,9400 4,2100 

18 Підрізька 1197,0000 854,4200 329,0400 0,1100 

19 Пісочненська 1282,0800 818,1700 26,1500   

20 Поворська 1778,6019 1222,0489 826,3839 1,3000 

21 Поповичівська 3250,4000 1315,7800 487,0900 51,4400 

22 Радошинська 2905,9515 835,6000 483,4500 16,4300 

23 Ситовичівська 846,2200 310,2100 460,3300 9,7300 

24 Сільцовська 2283,5300 851,5414 362,2800 24,1200 

25 Скулинська 1308,3700 646,0200 812,4900 3,6000 

26 Старокошарівська 2563,2704 832,3622 461,6954 35,9700 

27 Тойкутська 1505,2584 886,6265 458,2596 5,9700 

28 Уховецька 1228,7270 1103,2764 261,5562   

29 смт Голоби 3462,3563 1437,5760 811,5000 38,7600 

30 смт Люблинець 536,1349 275,4764 138,7161 13,9820 

31 м Ковель 855,5155 227,5902 124,8260 517,4400 
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Варіант № 7. Локачинський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Білопільська 1586,7000 190,7000   13,3000 

2 Бубнівська 2489,3000 290,9000 1,0000 41,4000 

3 Війницька 3785,7500 700,8000 280,1000 35,3000 

4 Дорогоничівська 1937,3200 176,6000   23,1000 

5 Замличівська 1584,6300 248,7000 26,7000 21,8000 

6 Затурцівська 4005,0300 561,4800 112,0000 27,1000 

7 Заячицівська 1787,6000 211,4000   6,1000 

8 Зубильненська 2239,9000 728,9500 184,3000 41,9000 

9 Кисилинська 1426,8000 563,7400 56,1000 7,8000 

10 Козлівська 1731,5000 189,6000 9,6000 20,4000 

11 Колпитівська 1829,6600 124,6000 9,8000 10,5000 

12 Конюхівська 1855,0000 120,3000 50,6000 12,6000 

13 Круханичівська 1485,6000 216,3000 30,7000 27,1000 

14 Марковичівська 1409,8000 194,3000 2,0000 10,8000 

15 Озютичівська 1806,5000 280,5000 251,8000 1,3000 

16 Привітненська 3436,5000 117,3300 32,4000 35,8000 

17 Старозагорівська 2967,8000 380,7000   41,2000 

18 Холопичівська 3106,5000 331,2800 290,1000 11,8000 

19 Шельвівська 3047,8100 489,0000 53,6000 35,5000 

20 смт Локачі 204,9000 98,7000 18,9000 22,4000 
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Варіант № 8. Луцький район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Баївська 1956,0741 72,4762 28,3000 44,1400 

2 Баківцівська 1864,0000 48,6000 124,8000 10,8000 

3 Білостоцька 1516,9200 34,5260 517,3400 11,0000 

4 Боголюбська 1466,4743 212,3000 29,6300 133,9700 

5 Боратинська 2094,9545 221,5870 450,0000 44,9600 

6 Буянівська 3240,9372 198,4000 301,9000 42,1600 

7 Веселівська 2508,4500 257,7544 128,2200 11,9200 

8 Воютинська 2551,3750 208,3200 216,2800 16,0400 

9 Гіркополонківська 2117,8973 86,6800 74,5717 55,1200 

10 Городищенська 1637,7900 110,6781 111,7752 11,6000 

11 Заборольська 3074,9085 296,8496 129,6990 45,5200 

12 Коршівська 1677,4600 37,0000   31,9900 

13 Лаврівська 2824,2980 142,0264 8,2000 183,7600 

14 Липинська 999,9024 105,9000 66,6000 67,0200 

15 Лищенська 2636,4500 358,7800 117,6666 151,7333 

16 Маяківська 2308,3174 287,2000 328,3615 585,9948 

17 Несвічівська 1833,6500 53,9400 116,2600 11,0600 

18 Одерадівська 2706,1700 230,7000 291,2700 14,8000 

19 Підгайцівська 2316,1748 318,6942 442,5900 89,0400 

20 Піддубцівська 1777,3900 258,8848 16,2000 64,7103 

21 Проміньська 3162,2319 194,2000 486,6066 182,7000 

22 Радомишльська 2665,0700 316,6258 59,9000 18,5200 

23 Ратнівська 1485,4400 74,7822   11,0400 

24 Романівська 2482,1461 295,0300 431,2116 75,0800 

25 Садівська 1847,5000 163,8000 38,9900 18,2000 

26 Смолигівська 2030,0000 153,7000 121,5000 13,6000 

27 Хорохоринська 2726,7300 496,0236 202,3000 10,6400 

28 Чаруківська 2540,5884 147,6797 100,6600 70,6700 

29 Шепельська 1864,9700 177,6037 40,5000 105,4600 

30 смт Рокині 1585,6269 101,5128 82,7000 41,4000 

31 смт Торчин 466,8201 23,9600 94,9000 24,6765 

32 м Луцьк 340,0000   531,0652 
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Варіант № 9. Любешівський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Березичівська 724,3600 387,0180 930,5470 7,6500 

2 Бихівська 1598,3800 665,9014 542,4800 6,7700 

3 Бірківська 1012,3300 603,4151 1061,8600 6,8200 

4 Великоглушанська 1528,5900 1279,2590 697,9000 11,6800 

5 Великокуріньська 1112,2101 404,2471 131,7500 22,5300 

6 Ветлівська 789,1100 429,4207 367,3100 5,8800 

7 Гірківська 768,5813 1359,4730 586,7600 3,7300 

8 Деревоцька 1447,1300 458,7843 240,6900 6,6900 

9 Дольська 766,1800 439,3588 748,6700 0,6900 

10 Залаззівська 1263,0844 1123,0827 816,8900 18,2600 

11 Залізницька 1413,0493 319,6755 597,0077 31,7700 

12 Зарудчівська 1150,3830 439,5477 123,2778 6,5000 

13 Люб'язівська 704,8200 790,3641 593,0209 0,2000 

14 Любешівсько-Волянська 1119,5822 831,4064 233,4700 11,0400 

15 Малоглушанська 959,6600 881,0550 544,1614 10,9000 

16 Седлищенська 2260,4600 477,9103 404,9855 10,0200 

17 Судченська 1880,0490 668,3268 798,9800 9,1900 

18 Хоцуньська 407,1984 317,7561 176,9900 1,1900 

19 Цирська 928,2000 716,4529 581,1000 12,0000 

20 Щитиньська 544,5500 651,0551 439,9900 10,3900 

21 смт Любешів 815,2511 178,7438 292,8000 8,9400 
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Варіант № 10. Любомльський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Бірківська 1549,5637 827,0780 289,0809 25,6352 

2 Вишнівська 2960,1559 1713,8691 1215,9343 76,4186 

3 Гущанська 1481,1912 419,0067 978,6835 8,0200 

4 Заболоттівська 1322,7869 626,1566 784,8900 2,4000 

5 Забузька 1280,0300 680,6162 738,8500 3,5300 

6 Запіллянська 1117,7500 937,5258 369,8970 6,6781 

7 Зачернеччанська 1130,3600 695,0754 389,9000 21,7000 

8 Згоранська 1424,0209 1014,6966 1391,3699 21,9546 

9 Куснищанська 2553,7516 1181,3087 674,4397 13,5900 

10 Ладиньська 1113,5062 964,3944 694,3130   

11 Машівська 1011,6479 566,6148 355,3700 17,1400 

12 Нудиженська 813,1614 348,0191 445,9869 2,0000 

13 Олеська 1956,3700 1184,3559 862,5163 16,8000 

14 Підгородненська 1322,5460 571,8547 314,3400 4,6200 

15 Полапівська 1147,2780 446,7382 303,4800 13,0000 

16 Почапівська 1273,6500 568,2921 335,5100 2,0000 

17 Радехівська 1725,1682 1420,1165 739,5232 17,8000 

18 Рівненська 1901,7392 1090,9763 876,4000 14,2600 

19 Столинсько-Смолярська 984,0915 600,4868 1059,3324 10,4200 

20 Хворостівська 1063,5641 415,1939 392,2741 9,5200 

21 Штуньська 2047,5272 894,9724 1462,6300 9,1600 

22 смт Головне 1971,9670 920,7217 907,0134 3,3603 

23 м Любомль 761,9071 627,9615 25,6500 70,0381 
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Варіант № 11. Маневицький район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Боровичівська 1849,1588 1398,1400 384,0018 16,8294 

2 Будківська 1008,3119 671,6131 533,2539 4,8942 

3 Великоведмежківська 1471,3928 417,4412 345,8648 8,4500 

4 Великоосницька 1169,9964 1348,0000 546,4008 4,7000 

5 Галузіївська 622,7138 318,3600 371,1147 3,1115 

6 Годомичівська 1286,4572 536,3700 366,9820 3,0308 

7 Гораймівська 1076,5444 252,9000 501,4556 4,1000 

8 Городоцька 797,2100 174,4000 310,0900 27,0000 

9 Довжицька 1788,3454 559,0900 745,1322 6,9198 

10 Карасинська 502,9019 758,4017 299,5614 18,0824 

11 Комарівська 1396,4000 856,3500 662,5632 24,2600 

12 Копиллянська 614,9400 323,4100 313,2500 1,8000 

13 Костюхнівська 1684,9224 514,5000 333,3346 10,7000 

14 Красновольська 2308,9477 1455,5455 774,8032 10,0543 

15 Куклинська 1036,0259 599,5500 752,2741 7,2500 

16 Куликовичівська 981,5696 763,5300 469,5210 2,7000 

17 Лишнівська 740,0358 235,3000 295,2642 2,9000 

18 Лісівська 730,4799 417,4400 380,4401 5,4000 

19 Новорудська 1041,6506 369,3600 506,8894 4,8000 

20 Оконська 218,9662 72,1063 65,9485 4,6000 

21 Прилісненська 440,9693 195,5400 551,3000 25,6529 

22 Рудниківська 2121,4512 1688,3138 679,4801 6,0800 

23 Серхівська 446,3175 226,8946 203,0825 2,0000 

24 Старосільська 2430,8386 1190,7000 646,4514 26,2000 

25 Старочорторийська 1636,2837 585,7100 421,9053 74,6294 

26 Троянівська 1355,8149 974,0032 959,7851 6,3000 

27 Цмінівська 2206,4764 1187,5952 300,2606 15,3000 

28 Черевахська 268,9000 106,1000 519,3316 14,2000 

29 Четвертнянська 2207,1275 988,9000 799,2367 11,0000 

30 Чорнижівська 1209,1000 175,2000 468,9285 8,8000 

31 смт Колки 642,8112 550,3410 487,3561 12,0000 

32 смт Маневичі 279,9078 137,4300 207,5398 25,8000 
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Варіант № 12. Ратнівський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Велимченська 1717,8494 1053,9000 1029,5000 12,3056 

2 Видраницька 1147,0000 1043,4857 855,0294 22,5706 

3 Височненська 1082,7000 1386,3000 862,0000 16,0000 

4 Гірниківська 2503,7432 1274,2149 890,2599 19,1851 

5 Гутянська 1565,2000 340,2000 755,0500 10,8000 

6 Датиньська 1028,4000 843,5000 583,3732 2,4685 

7 Жиричівська 1797,5661 1027,9900 858,8100 16,1000 

8 Забродівська 2163,9540 1538,0000 910,6000 24,0105 

9 Заліська 826,7709 632,1855 535,9253 20,0000 

10 Залухівська 1274,3535 458,1000 443,6000 10,6762 

11 Замшанівська 2079,1326 750,3100 575,4179 13,8232 

12 Здомишельська 1632,3624 434,7950 820,7216 22,0000 

13 Кортеліська 1460,6653 797,9892 331,9800 16,5000 

14 Межиситівська 754,1276 755,9600 382,2900 17,3224 

15 Млинівська 1631,9771 536,3280 461,4000 9,3812 

16 Поступельська 1251,6827 587,2000 455,7000 41,2699 

17 Прохідська 1600,2612 1136,6000 330,0000 12,7032 

18 Річицька 1865,2450 546,4890 818,9000 8,6498 

19 Самари-Оріховська 1065,9379 384,5747 404,0000 36,1000 

20 Самарська 1864,8948 1594,4908 1248,7000 23,5000 

21 Турська 1205,8085 348,5890 549,1900 15,0000 

22 Щедрогірська 1293,4470 989,5236 256,4000 23,3000 

23 смт Заболоття 611,5197 1046,1186 339,3639 26,0000 

24 смт Ратне 418,7419 208,3000 169,2523 75,3835 
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Варіант № 13. Рожищенський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Березолукська 3079,5158 526,4300 618,4965 12,0100 

2 Береська 1637,8450 390,9200 498,7394 25,8600 

3 Вічинівська 904,9127 535,0500 550,4879 4,4700 

4 Ворончинська 1971,0178 521,2962 422,7909 11,0000 

5 Городинівська 1029,3303 285,4800 245,2600 3,0800 

6 Доросинівська 2394,8923 593,8377 397,3800 17,6700 

7 Залісцівська 1339,2212 77,3000 28,8318 6,9890 

8 Іванчицівська 1665,9905 243,0900 41,2800 16,1703 

9 Кобченська 983,3510 111,4290 249,2200 8,2900 

10 Копачівська 2464,5693 465,3100 252,8000 36,0500 

11 Кременецька 1580,0557 17,5730 27,9900 12,9400 

12 Літогощанська 1210,0974 456,7248 447,3900 2,2908 

13 Луківська 1775,3105 496,2043 731,9300 8,9500 

14 Любченська 1112,9299 489,5700 238,9300 20,7094 

15 Мильська 1194,9896 394,7700 239,3343 10,9800 

16 Навізська 1046,1982 574,9000 628,6300 17,7500 

17 Немирська 1132,6663 446,1400 560,2500 22,8100 

18 Носачевичівська 1676,1023 605,2140 571,4400 41,7300 

19 Переспівська 3220,2961 1783,4359 543,1256 14,4800 

20 Пожарківська 1859,9646 935,5000 261,7355 16,2700 

21 Рудко-Козинська 1541,6940 131,5300 299,1099 16,2000 

22 Руднянська 1370,8322 517,1824 140,0800 6,8400 

23 Сокільська 1792,7834 871,0600 719,4672 7,5500 

24 Тихотинська 1344,2080 508,7000 423,3640 18,8700 

25 Топільненська 1772,6970 154,7500 350,1013 7,1000 

26 Уляниківська 1552,6619 212,8500 253,5711 8,0400 

27 Щуринська 2811,8860 732,9000 567,8686 31,8800 

28 Ясенівська 1614,7950 537,8000 248,6081 28,3750 

29 смт Дубище 154,5769 26,5700 5,4000 4,5300 

30 м Рожище 218,6590 89,8107 95,2693 68,9031 
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Варіант № 14. Старовижівський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Буцинська 1124,9170 414,0000 276,0000 3,6400 

2 Галиновольська 1351,8438 762,1000 443,1000 2,2000 

3 Глухська 1701,7912 537,4748 563,2233 9,2000 

4 Дубечненська 2826,1530 1489,5254 502,2395 6,8100 

5 Журавлинська 1404,9000 407,4786 551,9000 14,1000 

6 Кримненська 2235,2969 1167,7313 1226,6750 18,4600 

7 Любохинська 1173,6021 1265,7793 678,1906 7,9700 

8 Мизіовська 1806,5156 578,5000 784,2814 6,7000 

9 Нововижвівська 1050,2694 1006,1000 149,7000 5,5000 

10 Поліська 1506,8457 745,3000 203,9000 28,0000 

11 Руднянська 1162,0974 351,2000 513,5814 7,6000 

12 Седлищенська 1515,2975 686,1842 458,1231 1,1000 

13 Секуньська 1033,2532 375,9000 433,0837 1,9000 

14 Сереховичівська 2312,9945 832,7000 1524,5663 10,2000 

15 Синівська 1059,2108 322,6068 374,8000 2,0000 

16 Смідинська 4142,3285 1834,8000 981,0000 41,3000 

17 Соколищенська 1128,4788 427,9000 259,5000 8,6000 

18 Солов'ївська 1349,3800 575,4000 403,3000 14,5000 

19 Старогутівська 965,1000 686,9910 351,8000   

20 смт Стара Вижівка 708,3622 528,9541 195,0363 8,1200 
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Варіант № 15. Турійський район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Боблинська 3727,0000 982,0000 736,9300 34,5400 

2 Гайківська 1762,8900 1156,2700 353,9300 9,2400 

3 Дольська 1835,1264 544,3000 327,1000 26,1000 

4 Дулібинська 1575,2800 762,8800 172,1500 6,9100 

5 Клюська 1954,8700 1262,1000 350,1200 55,3200 

6 Кульчинська 2062,5600 486,4854 130,3000 7,6200 

7 Купичівська 3771,7875 923,9900 474,6200 33,2000 

8 Маковичівська 2296,7700 591,9900 460,0000 8,7800 

9 Миляновичівська 3532,7300 1353,5000 928,8000 17,1100 

10 Мокрецька 3296,1400 1152,9500 621,8300 18,3300 

11 Новодвірська 3881,3000 1636,0600 1032,5000 39,2400 

12 Новосілківська 2064,9400 618,0200 445,5800 27,2000 

13 Овлочинська 2669,1000 1359,3000 951,5000 15,2000 

14 Озерянська 1177,1700 975,3600 300,8900 15,1500 

15 Перевалівська 2267,1800 994,0000 583,0000 9,0400 

16 Ружинська 1695,9700 854,3200 568,9200 29,9800 

17 Селецька 1787,5100 1236,4588 155,2300 19,5100 

18 Соловичівська 2775,6600 712,2017 504,2900 9,8500 

19 Соминська 1132,3300 622,5366 466,0000 8,1200 

20 Туличівська 4327,3578 805,8000 634,8400 68,9000 

21 смт Луків 246,2400   93,3300 28,6400 

22 смт Турійськ 325,9748 96,4000 71,8300 70,4400 

 

Варіант № 16. Шацький район 

№ 
з/п 

Адміністративні утворення 

Сільськогосподарські угіддя, га 

рілля пасовища сіножаті 
багаторічні 

насадження 

1 Грабівська 1119,6500 657,8709 600,6800 7,6000 

2 Піщанська 2174,4458 605,5505 573,9300 13,2000 

3 Прип'ятська 1393,9000 490,8037 1053,5100 15,5000 

4 Пулимецька 797,0500 122,0200 175,7700   

5 Пульмівська 1532,3886 578,8059 409,2500 12,8000 

6 Ростаньська 929,4543 449,5413 616,2000 37,3000 

7 Самійличівська 1326,5800 379,0000 738,3800 5,8400 

8 Світязька 1230,6896 283,6506 573,5822 9,0000 

9 смт Шацьк 1562,0455 658,4903 520,3700 18,5500 
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Лабораторна робота № 6 

Тема: Укладання тематичної карти засобами ГІС MapInfo Professional 5.0  

(точковий спосіб та спосіб якісного фону) 

Мета: навчитись створювати і укладати електронну тематичну  карту регіону 

засобами ГІС MapІnfo Professional 5.0 шляхом комбінування 

способів картографічного зображення (точкового та якісного фону) 

Інформаційне забезпечення: статистичні матеріали структури земельного 

фонду сільськогосподарських угідь Волинської області у розрізі її 

адміністративних одиниць (форма 6-зем); шари цифрової карти 

Волинської області (Пацюкевич_Volun.tab, 

Пацюкевич_Volun_admin.tab, Пацюкевич_Volun_town.tab)  

Програмне забезпечення: географічна інформаційна система MapInfo 

Professional 5.0, табличний процесор  Microsoft Office Excel 

Звітні матеріали: файли картографічної бази даних Волинської області у 

форматі .tab, електронні документи робочих просторів з результатами 

аудиторної і самостійної роботи та їх паперові аналоги 

Термін виконання: 4 год 

Порядок виконання роботи 

1. За допомогою стандартних засобів операційної системи: через меню Пуск, 

піктограмою на робочому столі або на панелі Быстрый запуск 

(Пуск → Программы → GIS → MapІnfo → MapІnfo  Professional 5.0) 

запустіть програму ГІС MapInfo Professional 5.0. На початку сеансу 

роботи з геоінформаційною системою MapInfo Professional 5.0 слід 

відмовитись від відкриття попередньої сесії роботи з програмою, робочого 

простору та окремого шару електронної карти. Для цього у  діалоговому 

вікні Start Up натисніть Cancel. 

2. З папки Мои документы \ Data \ Stud завантажте електронний шар 

цифрової карти Волинської області Пацюкевич_Volun_admin.tab 

(контури районів). 

3. Використовуючи команду головного меню Table → Maintenance… → 

Table Structure змініть структуру шару адміністративного поділу 

Волинської області на райони (Пацюкевич_Volun_admin.tab) 

доповнивши її новими полями типу Integer з іменами Землекористувачі і 

Районування (рис. 6.1), які слід розмістити у кінці списку. 

4. Повторно завантажте електронний шар цифрової карти Волинської області: 

Пацюкевич_Volun_admin.tab (контури районів). 

5. Використовуючи піктограму відкриття табличного вікна New Browser або 

команду головного меню Window → New Browser Window… відкрийте 

таблицю атрибутивних даних адміністративного поділу Волинської 

області на райони Пацюкевич_Volun_admin та розгорніть її на усю 

робочу область ГІС MapInfo Professional 5.0. 
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Рис. 6.1. Вікно зміни структури таблиці атрибутивних даних   

Modify Table Structure 

6. Використовуючи статистичні дані чисельності власників землі та 

землекористувачів Волинської області у розрізі адміністративних одиниць 

(табл. 6.1) заповніть таблицю атрибутивних даних адміністративного 

поділу Волинської області Пацюкевич_Volun_admin, а тоді збережіть та 

закрийте її. 

Таблиця 3.6.1 

Чисельність власників землі та землекористувачів Волинської області  

(з урахуванням власників землі та землекористувачів міських рад)* 

№ 

з/п 
Назви районів 

Чисельність власників землі 

та землекористувачів 

1 Володимир-Волинський 40886 

2 Горохівський 55243 

3 Іваничівський 50113 

4 Камінь-Каширський 59670 

5 Ківерцівський 51964 

6 Ковельський 79741 

7 Локачинський 26894 

8 Луцький 87426 

9 Любешівський 37725 

10 Любомльський 40762 

11 Маневицький 51997 

12 Ратнівський 48647 

13 Рожищенський 42166 

14 Старовижівський 38075 

15 Турійський 31677 

16 Шацький 19288 

* за даними Головного управління Держземагенства у Волинській області 
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7. Використовуючи піктограми вибору об’єктів у колі Radius Select, 

прямокутнику Marquee Select або команду головного меню Query → 

Select… виділіть усі одиниці адміністративного поділу Волинської 

області. В останньому випадку у діалоговому вікні Select необхідно зняти 

прапорець Browse Results (рис. 6.2). 

 
Рис. 6.2. Вікно вибору об’єктів Select 

8. Використовуючи стандартні засоби роботи з об’єктами скопіюйте у буфер 

обміну виділені одиниці адміністративного поділу Волинської області. Для 

цього використайте команду головного меню Edit → Copy або комбінацію 

клавіш Ctrl + С. 

9. За допомогою стандартних засобів операційної системи: через меню Пуск, 

піктограмою на робочому столі або на панелі Быстрый запуск 

(Пуск → Программы → Microsoft Office → Microsoft Office Excel) 

запустіть табличний процесор Microsoft Office Excel. 

10. Використовуючи стандартні засоби роботи з об’єктами вставте з буферу 

обміну скопійовані дані (починаючи з комірки A1). Для цього викор истайте 

команду головного меню Правка → Вставить або комбінацію клавіш 

Ctrl + V. Результат порівняйте зі зразком, що поданий на рис. 6.3. 

 
Рис. 6.3. Вікно Microsoft Office Excel з атрибутивними даними  

електронного шару адміністративного поділу Волинської області  
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11. Використовуючи стандартні засоби пошуку та заміни даних у табличному 

процесорі Microsoft Office Excel у форматі дійсного числа замініть точку на  

кому. Для цього використайте команду головного меню 

Правка → Заменить… або комбінацію клавіш Ctrl + H. 

12. Використовуючи стандартні засоби заповнення комірок у табличному 

процесорі Microsoft Office Excel зафарбуйте колонки: F – жовтим (площа 

ріллі), G – блакитним (площа пасовищ), H – зеленим (площа сіножатей),  I –  

темно-зеленим (площа багаторічних насаджень). 

13. Використовуючи майстер вставки функцій у табличному процесорі 

Microsoft Office Excel у рядках 18 та 19 електронної таблиці визначте 

мінімальні і максимальні показники площ ріллі, пасовищ, сіножатей та 

багаторічних насаджень. 

14. Використовуючи посилання на комірки табличного процесора Microsoft 

Office Excel у 20 рядку електронної таблиці визначте варіаційний розмах 

статистичних рядів даних площ ріллі, пасовищ, сіножатей та багаторічних 

насаджень. 

15. Використовуючи критерій нормування (6.1) у колонках N, O, P, Q 

табличного процесора Microsoft Office Excel обчисліть нормовані значення  

площ ріллі, пасовищ, сіножатей та багаторічних насаджень для кожного 

району Волинської області. Результат порівняйте зі зразком, що пода ний на 

рис.6.4. 
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Рис. 6.4. Вікно табличного процесора Microsoft Office Excel з нормованими 

значеннями площ сільськогосподарських угідь 
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16. Використовуючи умовну класифікацію сільськогосподарських угідь (р ілля –  

1, пасовища – 2, сіножаті – 3, багаторічні насадження – 4) для кожного 

району Волинської області визначте класифікатор угіддя, нормоване 

значення якого є максимальним серед чотирьох показників (критерій 

Серенсена-Чекановського) та введіть його у колонку М.  

17. У папку Мои документы \ Data \ Stud збережіть електронну книгу 

Microsoft Office Excel під унікальним іменем (наприклад, 

Пацюкевич_GIS_6.xls, де Пацюкевич – прізвище студента, GIS – 

предмет, 6 – номер лабораторної роботи). 

18. Використовуючи стандартні засоби роботи в опер аційній системі Windows 

поверніться до програми ГІС MapInfo Professional 5.0, в якій відкрито 

картографічне вікно з електронним шаром адміністративного поділу 

Волинської області на райони (Пацюкевич_Volun_admin.tab). 

19. Використовуючи піктограму відкриття табличного вікна New Browser або 

команду головного меню Window → New Browser Window… відкрийте 

таблицю атрибутивних даних адміністративного поділу Волинської 

області на райони Пацюкевич_Volun_admin та розгорніть її на всю 

робочу область ГІС MapInfo Professional 5.0. 

20. Перемикаючи вікна програм Microsoft Office Excel та ГІС MapInfo 

Professional 5.0 з колонки М табличного процесора Microsoft Office Excel 

перенесіть дані у поле Районування ГІС MapInfo Professional 5.0, 

зберігаючи при цьому географічну відповідність. Збережіть таблицю ГІС 

MapInfo Professional 5.0 та закрийте її. 

21. З папки Мои документы \ Data \ Stud завантажте електронні шари 

цифрової карти Волинської області: Пацюкевич_Volun.tab (контур 

області) та Пацюкевич_Volun_town.tab (районні центри). 

22. Розмістіть по центру електронну карту Волинської області та 

використовуючи піктограми зміни масштабу відобразіть її відповідно до 

розмірів картографічного вікна Мар. 

23. Використовуючи менеджер шарів Layer Control за допомогою команд Up 

та Down змініть порядок відображення електронних шарів, перемістивши 

вниз шар контуру Волинської області Пацюкевич_Volun.tab і виведіть 

підписи районних центрів із наступними параметрами: власна назва – поле 

Назва; шрифт підпису – Arial CYR; розмір кегля – 12; стиль – Bold; колір 

– чорний; відступ – 2 пт на південний схід від його центроїда (при цьому 

слід враховувати, що підписи районних центрів зі зміною масштабу 

генералізуються). 

24. Використовуючи спосіб якісного фону за полем Районування створіть 

електронний шар спеціалізації сільськогосподарських угідь 

адміністративних районів Волинської області. Для цього використовуючи 

команду головного меню Map → Create Thematic Map… активуйте 

майстер побудови тематичних карт.  
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На першому кроці роботи майстру у діалоговому вікні Create Thematic 

Map – Step 1 of 3 (рис. 6.5) встановіть наступні параметри побудови шару 

тематичної карти: тип побудови Type – спосіб якісного фону Individual та 

шаблон оформлення тематичних змінних Template Name – стандартна 

кольорова гама Region IndValue Default.  

 
Рис. 6.5. Вікно першого кроку роботи майстру побудови тематичних карт 

способом якісного фону Create Thematic Map - Step 1 of 3 

На другому кроці роботи майстру у діалоговому вікні Create Thematic 

Map – Step 2 of 3 (рис.6.6) встановіть наступні параметри: таблиця, за 

якою здійснюється побудова тематичного шару Table: – Пацюкевич_ 

Volun_admin та поле тематичної змінної Field: – Районування.  

 
Рис. 6.6. Вікно другого кроку роботи майстру побудови тематичних карт 

способом якісного фону Create Thematic Map - Step 2 of 3 

На третьому кроці роботи майстру у діалоговому вікні Create Thematic 

Map – Step 3 of 3 здійсніть остаточне оформлення тематичної змінної та 

легенди тематичної карти. Для цього натисканням кнопки Styles… активуйте 

процедуру налаштування стилю оформлення тематичних змінних (р ис. 6.7) 

та підбору кольорової гами за критерієм спеціалізації 

сільськогосподарських угідь адміністративних районів Волинської області 

і встановіть наступні параметри кольору: 1 (рілля) – жовтий, 2 (пасовища) –  

блакитний, 3 (сіножаті) – зелений, 4 (багаторічні насадження) – темно-

зелений, після чого натисніть кнопку Ok. 
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Рис. 6.7. Вікно третього кроку роботи майстру побудови  

тематичних карт способом якісного фону Create Thematic  

Map - Step 3 of 3 (Customize Individual Styles) 

 
Рис.6.8. Вікно третього кроку роботи майстру побудови тематичних 

карт способом якісного фону Create Thematic Map - Step 3 of 3 

(Customize Legend) 

Після натискання кнопки Legend… змініть налаштування параметрів 

оформлення легенди (рис. 6.8) наступним чином: основний підпис Title: – 

Спеціалізація; додатковий підпис Subtitle: – сільськогосподарських угідь; 

розміщення легенди Into Window – нове вікно легенди New Legend Window; 

підписи типів угідь: рілля, пасовища, сіножаті, багаторічні насадження; 

видимість статистичних показників розподілу тематичної змінної у легенді 

Show Record Count – відсутня; шрифт – Arial CYR; розмір кегля – 12; 

колір – чорний для основного Title Font і додаткового Subtitle Font підписів 

легенди та підписів тематичної змінної Font і натисніть кнопку Ok. Результат 

виконаних дій відобразиться у діалоговому вікні Create Thematic 
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Map – Step 3 of 3 (рис. 6.10). Після завершення побудови електронного 

шару тематичної карти натисніть кнопку Ok. 

 
Рис. 6.10. Вікно третього кроку роботи майстру побудови тематичних 

карт способом якісного фону Create Thematic Map - Step 3 of 3 

25. Використовуючи команду головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. У робочій області 

програми відобразяться вікна електронного шару тематичної карти і 

легенди тематичної карти. 

26. Використовуючи піктограму зміни масштабу електронної карти Change 

View встановіть значення числового масштабу 1:1 500 000. Зміна 

масштабу цифрової карти здійснюється за допомогою команди головного 

меню Map → Change View. Розмістіть цифрову карту Волинської області 

по центру картографічного вікна Map. Оптимізуйте розміри вікна легенди 

тематичної карти. Результат роботи порівняйте зі зразком, що поданий на 

рис. 6.11. 

27. Активуйте картографічне вікно. 

28. Для відображення чисельності власників землі та землекористувачів у 

розрізі адміністративних районів Волинської області використайте 

точковий спосіб. Створення електронного шару тематичної карти 

здійснюється за допомогою команди головного меню Map → Create 

Thematic Map…, після чого активується майстер побудови тематичних 

карт.  

На першому кроці роботи майстру Step 1 of 3 у діалоговому вікні Create 

Thematic Map (рис.6.12) встановіть наступні параметри побудови шару 

тематичної карти: тип побудови Type – точковий спосіб Dot Density та 

шаблон оформлення тематичних змінних Template Name – точки чер воного 

кольору Dot Density, Red Dots.  
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Рис. 6.11. Вікна електронного шару тематичної карти і легенди 

тематичної карти (спосіб якісного фону) 

 
Рис. 6.12. Вікно першого кроку роботи майстру побудови тематичних карт 

точковим способом Create Thematic Map - Step 1 of 3 

На другому кроці роботи майстру у діалоговому вікні Create Thematic 

Map – Step 2 of 3 (рис. 6.13) встановіть наступні параметри побудови шару 

тематичної карти: ім’я таблиці, за якою здійснюється побудова 

тематичного шару Table: – Пацюкевич_Volun_admin, назва поля 

тематичної змінної Field: – Землекористувачі. 
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Рис. 6.13. Вікно другого кроку роботи майстру побудови тематичних карт 

точковим способом Create Thematic Map - Step 2 of 3 

На третьому кроці роботи майстру Step 3 of 3 у діалоговому вікні Create 

Thematic Map здійсніть остаточне оформлення тематичних змінних та 

легенди тематичної карти. Для цього натисканням кнопки Settings… 

активуйте процедуру налаштування стилю точок (рис. 6.14) і встановіть 

наступні параметри: вага Each Dot Represents: – 500, розмір Dot Size – 

Large і натисніть кнопку Ok. 

 
Рис.6.14. Вікно третього кроку роботи майстру побудови тематичних 

карт точковим способом Create Thematic Map - Step 3 of 3  

(Customize Dot Density Settings) 

Після натискання кнопки Legend… змініть налаштування параметрів 

оформлення легенди (рис. 6.15) наступним чином: основний підпис Title: – 

Чисельність власників землі; додатковий підпис Subtitle: – та 

землекористувачів, чол.; розміщення легенди Into Window – нове вікно 

легенди New Legend Window; підпис тематичної змінної – 500; шрифт – 

Arial CYR; розмір кегля – 12; колір – чорний для основного Title Font і 

додаткового Subtitle Font підписів легенди та підписів тематичної змінної 

Font і натисніть кнопку Ok.  

Результат виконаних дій відобразиться у діалоговому вікні Create Thematic 

Map – Step 3 of 3 (рис. 6.16). Після завершення побудови електронного 

шару тематичної карти натисніть кнопку Ok. 
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Рис. 6.15. Вікно третього кроку роботи майстру побудови тематичних карт 

точковим способом Create Thematic Map - Step 3 of 3 (Customize Legend) 

 
Рис. 6.16. Вікно третього кроку роботи майстру побудови тематичних 

карт точковим способом Create Thematic Map - Step 3 of 3 

29. Використовуючи команду головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. У робочій області 

програми відобразяться вікно електронних шарів тематичної карти і два 

вікна легенд тематичної карти. 

30. Використовуючи піктограму зміни масштабу електронної карти Change 

View встановіть значення числового масштабу 1:1 500 000. Зміна 

масштабу цифрової карти здійснюється за допомогою команди головного 

меню Map → Change View. Розмістіть цифрову карту Волинської області 

по центру картографічного вікна Map. Оптимізуйте розміри вікон легенд 

тематичної карти. Результат роботи порівняйте зі зразком, що поданий на 

рис. 6.17. 
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Рис. 6.17. Вікна електронних шарів тематичної карти і легенд тематичної 

карти (спосіб якісного фону і точковий спосіб) 

31. Використовуючи стандартні засоби ГІС MapInfo Professional 5.0 

побудуйте додруковий макет новоствореної тематичної карти Волинської 

області із стандартними параметрами. Побудова додрукового макету 

електронної карти здійснюється за допомогою команди головного меню 

Window → New Layout Window. У діалоговому вікні New Layout Window 

встановіть перемикач у положення Frames for All Currently Open 

Windows (рис. 6.18). 

 
Рис. 6.18. Вікно відкриття додрукового макету New Layout Window 

32. Встановіть параметри налаштування додрукового макету тематичної 

карти: формат – A4; орієнтування – Portrait; поля – 10 мм; кількість 

сторінок формату – 11 сторінка (по горизонталі і вертикалі). 

Налаштування параметрів друку електронної карти здійснюється за 

допомогою команди головного меню File →  Page Setup. Налаштування 

параметрів додрукового макету тематичної карти здійснюється за 

допомогою команди головного меню Layout →  Options… 
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33. Встановіть фіксований масштаб фреймів електронних карт. Для зміни 

масштабу у вікні додрукового макету Layout лівою кнопкою миші 

активуйте вікно параметрів фрейму Frame Object та у полі Scale on Paper 

встановіть значення іменованого масштабу в 1 см – 10 км (рис. 6.19). 

 
Рис. 6.19. Вікно встановлення параметрів фрейму Frame Object 

34. Для зміни стилю фрейму у вікні додрукового макету карти Layout 

командою головного меню Options → Region Style активуйте вікно зміни 

стилю площинного об’єкту та встановіть наступні параметри: у полі 

Pattern функціонального блоку Fill встановіть прозорий фон – None, а у 

полі Style функціонального блоку Border – відсутність контуру фрейму – 

None. 

35. Оформлення додрукового макету виконайте за зразком, що поданий на рис. 

6.20. 

36. У папку Мои документы \ Data \ Stud збережіть робочий простір під 

унікальним іменем (наприклад. Пацюкевич_GIS_6.wor. де Пацюкевич – 

прізвище студента. GIS – предмет. 6 – номер лабораторної роботи). 

37. Закрийте усі активні шари карти та програму MapInfo Professional 5.0. 
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Рис. 6.20. Приклад оформлення додрукового макету аудиторної роботи № 6 
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Завдання для самостійної роботи 

Відповідно до запропонованого варіанту для певного адміністративного 

району використовуючи статистичні матеріали структури земельного фонду 

сільськогосподарських угідь Волинської області у розрізі сільських, селищних 

та міських рад засобами ГІС MapInfo Professional 5.0: 1 – змініть структуру 

шару адміністративного поділу району, доповнивши її новими полями типу 

Integer з іменами Землекористувачі і Районування і заповніть таблицю 

атрибутивних даних показниками площ чисельності власників землі та 

землекористувачів Волинської області у розрізі адміністративних утворень; 2 –  

розрахуйте нормовані показники площ ріллі, пасовищ, сіножатей та багаторічних 

насаджень у розрізі адміністративних утворень; 3 – для кожного 

адміністративного утворення визначте класифікатор угіддя, нормоване значення 

якого є максимальним серед чотирьох нормованих показників 

сільськогосподарських угідь (критерій Серенсена-Чекановського) та заповнінь 

цим показником поле Районування; 4 – створіть макет карти з тематичними 

шарами показників спеціалізації сільськогосподарських угідь адміністративних 

утворень району (спосіб якісного фону), показників чисельності власників 

землі та землекористувачів у розрізі адміністративних утворень районів 

(точковий спосіб) та шару центрів сільських, селищних та міських рад. 

Використовуючи правила оформлення додрукового макету у ГІС MapInfo 

Professional 5.0, сформувати документ із результатами виконання завдань 

самостійної роботи і оформити його відповідно до поданого зразка (рис. 6.21). 
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Рис. 6.21. Приклад оформлення додрукового макету самостійної роботи № 6 
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Варіанти завдань для самостійної роботи 

Варіант № 1. Володимир-Волинський район 

№ 
з/п 

Адміністративні утворення 
Чисельність власників землі 

та землекористувачів, чол. 

1 Березовицька 2226 

2 Білинська 828 

3 Бубнівська 1055 

4 Галинівська 1220 

5 Зарічанська 4045 

6 Зимневська 2510 

7 Зорянська 656 

8 Красноставська 855 

9 Ласківська 958 

10 Лудинська 1178 

11 Льотничівська 3062 

12 Микитичівська 886 

13 Оваднівська 3377 

14 П'ятиднівська 1030 

15 Рогожанська 695 

16 Селецька 835 

17 Стенжаричівська 1061 

18 Хмелівківська 1426 

19 Хобултівська 1242 

20 Хотячівська 605 

21 м Устилуг 2536 

22 м Володимир-Волинський 8633 
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Варіант № 2. Горохівський район 

№ 
з/п 

Адміністративні утворення 
Чисельність власників землі та 

землекористувачів, чол. 

1 Бережанська 560 

2 Бранівська 1848 

3 Бужанівська 2212 

4 Ватинська 516 

5 Вільхівська 968 

6 Галичанська 1209 

7 Горішнянська 1034 

8 Губинська Перша 714 

9 Жабченська 611 

10 Журавниківська 1253 

11 Звиняченська 1525 

12 Квасівська 1754 

13 Колодеженська 1191 

14 Лемешівська 1138 

15 Лобачівська 1289 

16 Мервинська 1857 

17 Мирківська 903 

18 Мирненська 1376 

19 Михлинська 403 

20 Новосілківська 1251 

21 Перемильська 2917 

22 Печихвостівська 2044 

23 Підбереззівська 1209 

24 Пірванченська 2033 

25 Пісківська 1435 

26 Пустомитівська 1151 

27 Рачинська 1689 

28 Скірченська 584 

29 Скобелківська 2569 

30 Скриговська 734 

31 Смолявська 1488 

32 смт Мар'янівка 1400 

33 смт Сенкевичівка 1404 

34 Терешківцівська 848 

35 Угринівська 756 

36 Холонівська 1157 

37 Цегівська 3601 

38 Шклиньська 957 

39 м Берестечко 898 

40 м Горохів 2875 
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Варіант № 3. Іваничівський район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Бужанська 2513 

2 Грибовицька 992 

3 Грядівська 2398 

4 Жашковичівська 565 

5 Заболотцівська 1322 

6 Завидівська 827 

7 Заставненська 1120 

8 Колонська 981 

9 Литовезька 1554 

10 Луковичівська 1039 

11 Милятинська 1338 

12 Мишівська 1951 

13 Мовниківська 1009 

14 Морозовичівська 985 

15 Павлівська 1133 

16 Переславичівська 1084 

17 Поромівська 1867 

18 Радовичівська 486 

19 Риковичівська 985 

20 Соснинська 1057 

21 Старолішнянська 1689 

22 Старопорицька 513 

23 Тополищенська 533 

24 смт Іваничі 4125 

25 м Нововолинськ 18092 
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Варіант № 4. Камінь-Каширський район 

№ 
з/п 

Адміністративні утворення 
Чисельність власників землі 
та землекористувачів, чол. 

1 Боровненська 1470 

2 Броницька 1950 

3 Бузаківська 2248 

4 Великообзирська 1072 

5 Верхівська 651 

6 Видертська 2529 

7 Видричівська 1924 

8 Воєгощанська 1555 

9 Ворокомлівська 1951 

10 Грудківська 1547 

11 Гута-Боровенська 1538 

12 Добренська 1529 

13 Залісська 918 

14 Карасинська 1239 

15 Качинська 1804 

16 Клітицька 1004 

17 Личинівська 882 

18 Мельнико-Мостищенська 1560 

19 Новочервищанська 2023 

20 Нуйнівська 1769 

21 Олениненська 1253 

22 Осівецька 1190 

23 Піщанська 1155 

24 Пнівненська 3242 

25 Полицівська 1414 

26 Раково-Ліська 2806 

27 Сошичненська 2163 

28 Стобихівська 1080 

29 Тобольська 1693 

30 Хотешівська 2791 

31 Черченська 3137 

32 м Камінь-Каширський 6584 
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Варіант № 5. Ківерцівський район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Берестянська 955 

2 Борохівська 2206 

3 Грем'яченська 1387 

4 Дернівська 2843 

5 Дідичівська 2429 

6 Дубищенська 1310 

7 Жидичинська 3081 

8 Жорнищенська 1316 

9 Журавичівська 1718 

10 Завітненська 1123 

11 Звірівська 1607 

12 Карпилівська 1263 

13 Липненська 1590 

14 Макаревичівська 1016 

15 Озерська 1073 

16 Озерцівська 1644 

17 Покащівська 1041 

18 Прилуцька 2543 

19 Сильненська 1644 

20 Сокиричівська 2616 

21 Суська 1818 

22 Тростянецька 1948 

23 Холоневичівська 1738 

24 Хорлупівська 1216 

25 смт Олика 4069 

26 смт Цумань 2681 

27 м Ківерці 4148 
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Варіант № 6. Ковельський район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Білашівська 1726 

2 Білинська 2134 

3 Велицька 1515 

4 Городищенська 803 

5 Доротищенська 887 

6 Дрозднівська 1195 

7 Дубовська 2703 

8 Зеленська 1468 

9 Козлиничівська 1641 

10 Колодяжненська 2015 

11 Кричевичівська 2398 

12 Любитівська 3163 

13 Майданська 759 

14 Мельницька 1738 

15 Мощенська 1406 

16 Новомосирська 1563 

17 Облапська 1278 

18 Підрізька 1196 

19 Пісочненська 1121 

20 Поворська 2808 

21 Поповичівська 2361 

22 Радошинська 1672 

23 Ситовичівська 1175 

24 Сільцовська 2205 

25 Скулинська 1630 

26 Старокошарівська 1675 

27 Тойкутська 1956 

28 Уховецька 885 

29 смт Голоби 4538 

30 смт Люблинець 1706 

31 м Ковель 26642 
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Варіант № 7. Локачинський район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Білопільська 743 

2 Бубнівська 1038 

3 Війницька 2676 

4 Дорогоничівська 1155 

5 Замличівська 984 

6 Затурцівська 2730 

7 Заячицівська 755 

8 Зубильненська 907 

9 Кисилинська 650 

10 Козлівська 1339 

11 Колпитівська 756 

12 Конюхівська 908 

13 Круханичівська 993 

14 Марковичівська 707 

15 Озютичівська 717 

16 Привітненська 2320 

17 Старозагорівська 1818 

18 Холопичівська 1988 

19 Шельвівська 1292 

20 смт Локачі 2418 
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Варіант № 8. Луцький район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Баївська 1931 

2 Баківцівська 723 

3 Білостоцька 1009 

4 Боголюбська 3368 

5 Боратинська 5118 

6 Буянівська 2378 

7 Веселівська 875 

8 Воютинська 1236 

9 Гіркополонківська 3012 

10 Городищенська 694 

11 Заборольська 2934 

12 Коршівська 897 

13 Лаврівська 3690 

14 Липинська 2326 

15 Лищенська 4598 

16 Маяківська 5314 

17 Несвічівська 925 

18 Одерадівська 961 

19 Підгайцівська 4931 

20 Піддубцівська 2265 

21 Проміньська 4633 

22 Радомишльська 1211 

23 Ратнівська 735 

24 Романівська 1953 

25 Садівська 1632 

26 Смолигівська 1047 

27 Хорохоринська 996 

28 Чаруківська 1299 

29 Шепельська 2496 

30 смт Рокині 2207 

31 смт Торчин 1819 

32 м Луцьк 18213 
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Варіант № 9. Любешівський район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Березичівська 1453 

2 Бихівська 1608 

3 Бірківська 1991 

4 Великоглушанська 3068 

5 Великокуріньська 1350 

6 Ветлівська 1594 

7 Гірківська 1814 

8 Деревоцька 1159 

9 Дольська 1353 

10 Залаззівська 2594 

11 Залізницька 2270 

12 Зарудчівська 2215 

13 Люб'язівська 1288 

14 Любешівсько-Волянська 1152 

15 Малоглушанська 2082 

16 Седлищенська 1949 

17 Судченська 1871 

18 Хоцуньська 660 

19 Цирська 1883 

20 Щитиньська 941 

21 смт Любешів 3456 
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Варіант № 10. Любомльський район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Бірківська 1382 

2 Вишнівська 3194 

3 Гущанська 1964 

4 Заболоттівська 1532 

5 Забузька 1667 

6 Запіллянська 1280 

7 Зачернеччанська 1112 

8 Згоранська 2693 

9 Куснищанська 2541 

10 Ладиньська 911 

11 Машівська 793 

12 Нудиженська 1795 

13 Олеська 1540 

14 Підгородненська 854 

15 Полапівська 1342 

16 Почапівська 1264 

17 Радехівська 1657 

18 Рівненська 1746 

19 смт Головне 3275 

20 Столинсько-Смолярська 1606 

21 Хворостівська 1379 

22 Штуньська 1852 

23 м Любомль 3504 
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Варіант № 11. Маневицький район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Боровичівська 2424 

2 Будківська 1089 

3 Великоведмежківська 822 

4 Великоосницька 1725 

5 Галузіївська 1023 

6 Годомичівська 674 

7 Гораймівська 1235 

8 Городоцька 1185 

9 Довжицька 2083 

10 Карасинська 1074 

11 Комарівська 1800 

12 Копиллянська 961 

13 Костюхнівська 1514 

14 Красновольська 3031 

15 Куклинська 1666 

16 Куликовичівська 1138 

17 Лишнівська 813 

18 Лісівська 869 

19 Новорудська 1613 

20 Оконська 572 

21 Прилісненська 1708 

22 Рудниківська 2295 

23 Серхівська 642 

24 Старосільська 2578 

25 Старочорторийська 2573 

26 Троянівська 2045 

27 Цмінівська 2129 

28 Черевахська 684 

29 Четвертнянська 2195 

30 Чорнижівська 1938 

31 смт Колки 2774 

32 смт Маневичі 3125 
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Варіант № 12. Ратнівський район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Велимченська 3305 

2 Видраницька 1918 

3 Височненська 847 

4 Гірниківська 3372 

5 Гутянська 1643 

6 Датиньська 1455 

7 Жиричівська 2235 

8 Забродівська 2356 

9 Заліська 1278 

10 Залухівська 1349 

11 Замшанівська 2277 

12 Здомишельська 1993 

13 Кортеліська 1405 

14 Межиситівська 1074 

15 Млинівська 1449 

16 Поступельська 1437 

17 Прохідська 2125 

18 Річицька 2285 

19 Самари-Оріховська 2370 

20 Самарська 2556 

21 Турська 1454 

22 Щедрогірська 1901 

23 смт Заболоття 2477 

24 смт Ратне 4244 
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Варіант № 13. Рожищенський район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Березолукська 1572 

2 Береська 734 

3 Вічинівська 572 

4 Ворончинська 1225 

5 Городинівська 431 

6 Доросинівська 1999 

7 Залісцівська 932 

8 Іванчицівська 1020 

9 Кобченська 526 

10 Копачівська 2266 

11 Кременецька 1581 

12 Літогощанська 1128 

13 Луківська 1641 

14 Любченська 891 

15 Мильська 1043 

16 Навізська 1533 

17 Немирська 855 

18 Носачевичівська 2094 

19 Переспівська 2349 

20 Пожарківська 1506 

21 Рудко-Козинська 1288 

22 Руднянська 1525 

23 Сокільська 2140 

24 Тихотинська 783 

25 Топільненська 1856 

26 Уляниківська 832 

27 Щуринська 2145 

28 Ясенівська 875 

29 смт Дубище 952 

30 м Рожище 3885 
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Варіант № 14. Старовижівський район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Буцинська 1465 

2 Галиновольська 1914 

3 Глухська 1968 

4 Дубечненська 4045 

5 Журавлинська 812 

6 Кримненська 2881 

7 Любохинська 2250 

8 Мизіовська 1523 

9 Нововижвівська 1338 

10 Поліська 1773 

11 Руднянська 1037 

12 Седлищенська 1362 

13 Секуньська 1018 

14 Сереховичівська 2030 

15 Синівська 1168 

16 Смідинська 3796 

17 Соколищенська 1117 

18 Солов'ївська 1528 

19 Старогутівська 1559 

20 смт Стара Вижівка 3597 
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Варіант № 15. Турійський район 

№ 

з/п 
Адміністративні утворення 

Чисельність власників землі та 
землекористувачів, чол. 

1 Боблинська 1898 

2 Гайківська 984 

3 Дольська 864 

4 Дулібинська 640 

5 Клюська 1493 

6 Кульчинська 685 

7 Купичівська 1758 

8 Маковичівська 869 

9 Миляновичівська 1435 

10 Мокрецька 1627 

11 Новодвірська 1515 

12 Новосілківська 1259 

13 Овлочинська 1355 

14 Озерянська 871 

15 Перевалівська 873 

16 Ружинська 1105 

17 Селецька 919 

18 Соловичівська 1729 

19 Соминська 538 

20 Туличівська 1910 

21 смт Луків 3762 

22 смт Турійськ 3640 

 

Варіант № 16. Шацький район 

№ 
з/п 

Адміністративні утворення 
Чисельність власників землі та 

землекористувачів, чол. 

1 Грабівська 1254 

2 Піщанська 2550 

3 Прип'ятська 1463 

4 Пулимецька 920 

5 Пульмівська 2517 

6 Ростаньська 1271 

7 Самійличівська 1057 

8 Світязька 2188 

9 смт Шацьк 6068 

 



 119 

Лабораторна робота № 7 

Тема: Укладання тематичної карти засобами ГІС MapІnfo Professional 5.0  

(способи значків та ізоліній) 

Мета: навчитись створювати і укладати електронну тематичну карту  регіону 

засобами ГІС MapІnfo Professional 5.0 шляхом комбінування 

способів картографічного зображення (способами значків та  ізоліній) 

Інформаційне забезпечення: статистичні матеріали структури земельного 

фонду сільськогосподарських угідь Волинської області у розрізі її 

адміністративних одиниць (форма 6-зем), статистичні матеріали 

чисельності населення в центрах адміністративних утворень 

Волинської області; шари цифрової карти Волинської області 

(Пацюкевич_Volun.tab, Пацюкевич_Volun_admin.tab, 

Пацюкевич_Volun_town.tab) 

Програмне забезпечення: географічна інформаційна система Maplnfo 

Professional 5.0 

Звітні матеріали: файли картографічної бази даних Волинської області у 

форматі .tab, електронні документи робочих просторів з результатами 

аудиторної і самостійної роботи та їх паперові аналоги 

Термін виконання: 4 год 

Порядок виконання роботи 

1. За допомогою стандартних засобів операційної системи: через меню Пуск, 

піктограмою на робочому столі або на панелі Быстрый запуск 

(Пуск → Программы → GIS → MapІnfo → MapІnfo  Professional 5.0) 

запустіть програму ГІС MapInfo Professional 5.0. На початку сеансу 

роботи з геоінформаційною системою MapInfo Professional 5.0 слід 

відмовитись від відкриття попередньої сесії роботи з програмою, робочого 

простору та окремого шару електронної карти. Для цього у діалоговому 

вікні Start Up натисніть Cancel. 

2. З папки Мои документы \ Data \ Stud завантажте електронні шари 

цифрової карти Волинської області: Пацюкевич_Volun.tab (контур 

області), Пацюкевич_Volun_admin.tab (контури районів) та 

Пацюкевич_Volun_town.tab (районні центри). 

3. Розмістіть по центру електронну карту Волинської області та 

використовуючи піктограми зміни масштабу відобразіть її відповідно до 

розмірів картографічного вікна Мар. 

4. Використовуючи команду головного меню Table → Maintenance… → 

Table Structure змініть структуру шару центрів адміністративних утворень 

Волинської області (Пацюкевич_Volun_town), доповнивши його новим 

полем типу Integer з іменем Чисельність_населення (рис. 7.1). 
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Рис. 7.1. Вікно зміни структури таблиці атрибутивних даних 

Modify Table Structure 

5. Повторно завантажте електронний шар цифрової карти Волинської області 

Пацюкевич_Volun_town.tab (районні центри). 

6. Використовуючи команду Label менеджера шарів Layer Control виведіть 

підписи центрів адміністративних одиниць Волинської області із 

наступними параметрами: власна назва – поле Назва; шрифт підпису – 

Arial CYR; розмір кегля – 12; стиль – Bold; колір – чорний; відступ – 2 пт 

на південний схід від його центроїда (при цьому слід враховувати, що 

підписи районних центрів зі зміною масштабу генералізуються). 

7. Використовуючи піктограму відкриття табличного вікна New Browser або 

команду головного меню Window → New Browser Window… відкрийте 

таблицю атрибутивних даних центрів адміністративних одиниць 

Волинської області Пацюкевич_Volun_ town та розгорніть її на всю 

робочу область ГІС MapInfo Professional 5.0.  

8. Використовуючи статистичні матеріали чисельності населення у центрах 

адміністративних одиниць Волинської області (табл. 7.1) заповніть 

відповідне новостворене поле таблиці атрибутивних даних 

Пацюкевич_Volun_ town та збережіть її. 

9. Для відображення чисельності власників землі та землекористувачів у 

розрізі адміністративних одиниць Волинської області використайте спосіб 

ізоліній, зокрема псевдоізоліній з градієнтною заливкою кольором. 

Створення електронного шару тематичної карти здійснюється за 

допомогою команди головного меню Map → Create Thematic Map…, 

після чого активується майстер побудови тематичних карт. 

На першому кроці роботи майстру Step 1 of 3 у діалоговому вікні Create 

Thematic Map (рис. 7.2) встановіть наступні параметри побудови 

електронного шару тематичної карти: тип побудови Type – спосіб ізоліній 

Grid, шаблон оформлення Template Name – стандартна кольорова шкала 

пошарового розфарбування Grid Default. 
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Таблиця 7.1 

Чисельність населення у районних центрах  

Волинської області* 

№ 

з/п 
Назви районів 

Чисельність 

населення, чол. 

1 Володимир-

Волинський 

38894 

2 Горохів 9186 

3 Іваничі 7183 

4 Камінь-Каширський 12000 

5 Ківерці 14916 

6 Ковель 69239 

7 Локачі 3941 

8 Луцьк 216714 

9 Любешів 7645 

10 Любомль 10129 

11 Маневичі 11594 

12 Ратне 10000 

13 Рожище 13505 

14 Стара Вижівка 5151 

15 Турійськ 5866 

16 Шацьк 5370 

*за даними сайту www.uk.wikipedia.org 

 
Рис. 7.2. Вікно першого кроку роботи майстру побудови тематичних карт 

способом ізоліній Create Thematic Map - Step 1 of 3 

http://www.uk.wikipedia.org/
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На другому кроці роботи майстру Step 2 of 3 у діалоговому вікні Create 

Thematic Map (рис. 7.3) встановіть наступні параметри побудови 

електронного шару тематичної карти: ім’я таблиці, за якою здійснюється 

побудова тематичного шару Table: – Пацюкевич_Volun_admin, назва 

поля тематичної змінної Field: – Землекористувачі, ігнорування нульових 

та відсутніх даних у полі – активне, ім’я шару (зовнішньої межі) для 

відсікання растрової поверхні Select a Table of Boundaries to Clip Against –  

Пацюкевич_Volun, ім’я шару для автоматичного зберігання растрової 

поверхні Grid file Name: – Пацюкевич_GIS_7 (де Пацюкевич – прізвище 

студента. GIS – предмет, 7 – номер лабораторної роботи). 

 
Рис. 7.3. Вікно другого кроку роботи майстру побудови тематичних карт 

способом ізоліній Create Thematic Map - Step 2 of 3 

 
Рис.7.4. Вікно третього кроку роботи майстру побудови тематичних карт 

способом ізоліній Create Thematic Map - Step 3 of 3  

(IDW Interpolator Settings) 

На третьому кроці роботи майстру Step 3 of 3 у діалоговому вікні Create 

Thematic Map здійсніть остаточне оформлення шкали ізоліній та легенди 

тематичної карти. Для цього після натискання кнопки Settings… (рис. 7.4) 
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встановіть наступні параметри побудови растрової поверхні: розмір комір ки 

Cell Size: – 0.2 км, степінь Exponent – 7, радіус пошуку точок Search Radius: 

– 187 км, товщина рамки Grid Border: – 0 км  і натисніть кнопку Ok.  

 
Рис. 7.5. Вікно третього кроку роботи майстру побудови тематичних 

карт способом ізоліній Create Thematic Map - Step 3 of 3 (Grid Color) 

Після натискання кнопки Styles… (рис.7.5) змініть параметри налаштування 

стилю оформлення кольорової палітри регулярної сітки растрової поверхні, 

встановивши граничні значення для кольорів наступним чином: синього  –  0 , 

блакитного – 25 000, зеленого – 50 000, жовтого – 75 000, червоного – 

100 000 і натисніть кнопку Ok.  

 
Рис. 7.6. Вікно третього кроку роботи майстру побудови тематичних карт 

способом ізоліній Create Thematic Map - Step 3 of 3 (Customize Legend) 

Після натискання кнопки Legend… (рис. 7.6) змініть налаштування 

параметрів оформлення легенди наступним чином: основний підпис Title: –  

Чисельність власників землі; додатковий підпис Subtitle: – та 

землекористувачів, чол.; розміщення легенди Into Window – нове вікно 

легенди New Legend Window; шрифт – Arial CYR; розмір кегля – 12; колір  
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– чорний для основного Title Font і додаткового Subtitle Font підписів 

легенди та підписів інтервалів Font і натисніть кнопку Ok. Результат 

виконаних дій відобразиться у діалоговому вікні Create Thematic Map – 

Step 3 of 3 (рис. 7.7). Після завершення побудови електронного шару 

тематичної карти натисніть кнопку Ok. 

 
Рис. 7.7. Вікно третього кроку роботи майстру побудови тематичних 

карт способом ізоліній Create Thematic Map - Step 3 of 3 

10. Використовуючи команду головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. У робочій області 

програми відобразяться вікна електронного шару тематичної карти і 

легенди тематичної карти. 

11. Використовуючи піктограму зміни масштабу електронної карти Change 

View встановіть значення числового масштабу 1:1 500 000. Зміна 

масштабу цифрової карти здійснюється за допомогою команди головного 

меню Map → Change View. Розмістіть цифрову карту Волинської області 

по центру картографічного вікна Map. Оптимізуйте розміри вікна легенди 

тематичної карти. Результат роботи порівняйте зі зразком на рис. 7.8.  

12. Активуйте картографічне вікно. 

13. Використовуючи команду Display менеджера шарів Layer Control 

встановіть параметри відображення контурів центрів адміністративних 

одиниць Волинської області Пацюкевич_Volun_town. Для цього у 

діалоговому вікні Пацюкевич_Volun_town Display Options встановіть 

параметри оформлення площинних об’єктів: тип лінії контуру – відсутній; 

колір заповнення – відсутній. 

14. Для відображення чисельності населення центрів адміністративних 

одиниць Волинської області використайте спосіб значків у найпростішому 

варіанті – градуйовані символи. Створення електронного шару тематичної 

карти здійснюється за допомогою команди головного меню Map → Create 

Thematic Map…, після чого активується майстер побудови тематичних 

карт. 
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Рис. 7.8. Вікна електронного шару тематичної карти і легенди 

тематичної карти (спосіб ізоліній) 

На першому кроці роботи майстру Step 1 of 3 у діалоговому вікні Create 

Thematic Map (рис. 7.9) встановіть наступні параметри побудови 

електронного шару тематичної карти: тип побудови Type – спосіб значків 

Graduated; шаблон оформлення тематичних змінних Template Name – 

стандартні градуйовані символи червоного кольору Graduated Symbol 

Default.  

 
Рис. 7.9. Вікно першого кроку роботи майстру побудови тематичних карт 

способом значків Create Thematic Map - Step 1 of 3 
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На другому кроці роботи майстру Step 2 of 3 у діалоговому вікні Create 

Thematic Map (рис. 7.10) встановіть наступні параметри побудови шару 

тематичної карти: ім’я таблиці, за якою здійснюється побудова 

тематичного шару Table: – Пацюкевич_Volun_town, назва поля 

тематичної змінної Field: – Чисельність_населення. 

 
Рис. 7.10. Вікно другого кроку роботи майстру побудови тематичних карт 

способом значків Create Thematic Map - Step 2 of 3 

На третьому кроці роботи майстру Step 3 of 3 у діалоговому вікні Create 

Thematic Map здійсніть остаточне оформлення фігур значків та легенди 

тематичної карти. Для цього після натискання кнопки Settings… (рис. 7.11) 

змініть параметри налаштування стилю оформлення значків: шрифт – 

MapInfo 3.0 Compatible; розмір кегля – 48; колір – червоний, максимальне 

значення at value – 200 000,. Після цього натисніть кнопку Ok. 

 
Рис. 7.11. Вікно третього кроку роботи майстру побудови тематичних 

карт способом значків Create Thematic Map - Step 3 of 3  

(Customize Graduated Symbols) 

Після натискання кнопки Legend… змініть налаштування параметрів 

оформлення легенди (рис. 7.12) наступним чином: основний підпис Title: – 

Чисельність населення, чол.; додатковий підпис Subtitle: – відсутній; 

розміщення легенди Into Window – нове вікно легенди New Legend Window; 

шрифт – Arial CYR; розмір кегля – 12; колір – чорний для основного Title 

Font, додаткового Subtitle Font підписів легенди та підписів назв тематичних 
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змінних Font і натисніть кнопку Ok.  

 
Рис. 7.12. Вікно третього кроку роботи майстру побудови тематичних 

карт способом значків Create Thematic Map - Step 3 of 3  

(Customize Legend) 

Результат виконаних дій відобразиться у діалоговому вікні Create Thematic 

Map – Step 3 of 3 (рис. 7.13). Після завершення побудови електронного 

шару тематичної карти натисніть кнопку Ok. 

 
Рис. 7.13. Вікно третього кроку роботи майстру побудови тематичних 

карт способом значків Create Thematic Map - Step 3 of 3 

15. Використовуючи команду головного меню Window → Tile Windows 

впорядкуйте активні вікна ГІС MapInfo Professional 5.0. У робочій області 

програми відобразяться вікно електронних шарів тематичної карти і два 

вікна легенд тематичної карти. 

16. Використовуючи піктограму зміни масштабу електронної карти Change 

View встановіть значення числового масштабу 1:1 500 000. Зміна 

масштабу цифрової карти здійснюється за допомогою команди головного 

меню Map → Change View. Розмістіть цифрову карту Волинської області 
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по центру картографічного вікна Map. Оптимізуйте розміри вікон легенд 

тематичної карти. Результат роботи порівняйте зі зразком, що поданий на 

рис. 7.14. 

 
Рис. 7.14. Вікна електронних шарів тематичної карти і легенд 

тематичної карти (спосіб ізоліній і значків) 

17. Використовуючи стандартні засоби ГІС MapInfo Professional 5.0 

побудуйте додруковий макет новоствореної тематичної карти Волинської 

області із стандартними параметрами. Побудова  додрукового макету 

електронної карти здійснюється за допомогою команди головного меню 

Window → New Layout Window. У діалоговому вікні New Layout Window 

встановіть перемикач у положення Frames for All Currently Open 

Windows (рис. 7.15). 

18. Встановіть параметри налаштування додрукового макету електронної 

карти: формат паперу – A4; орієнтування паперу – Portrait; поля – 10 мм; 

кількість сторінок формату – 11 сторінка (по горизонталі і вертикалі). 

Налаштування параметрів друку електронної карти здійснюється за 

допомогою команди головного меню File →  Page Setup. Налаштування 

параметрів додрукового макету електронної карти здійснюється за 

допомогою команди головного меню Layout →  Options…  

19. Встановіть фіксований масштаб фреймів електронних карт. Для зміни 

масштабу у вікні додрукового макету Layout лівою кнопкою миші 

активуйте вікно параметрів фрейму Frame Object та у полі Scale on Paper 

встановіть числове значення іменованого масштабу в 1 см – 10 км (рис. 

7.16). 
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Рис. 7.15. Вікно відкриття додрукового макету New Layout Window 

 
Рис. 7.16. Вікно встановлення параметрів фрейму Frame Object 

20. Для зміни стилю фрейму у вікні додрукового макету карти Layout 

командою головного меню Options → Region Style активуйте вікно зміни 

стилю площинного об’єкту та встановіть наступні параметри: у полі 

Pattern функціонального блоку Fill встановіть прозорий фон – None, а у 

полі Style функціонального блоку Border – відсутність контуру фрейму – 

None. 

21. Оформлення додрукового макету виконайте за зразком, що поданий на рис. 

7.17. 

22. У папку Мои документы \ Data \ Stud збережіть робочий простір під 

унікальним іменем (наприклад, Пацюкевич_GIS_7.wor, де Пацюкевич – 

прізвище студента, GIS – предмет, 7 – номер лабораторної роботи). 

23. Закрийте усі активні шари карти та програму MapInfo Professional 5.0. 
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Рис. 7.17. Приклад оформлення додрукового макету аудиторної роботи № 7 
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Завдання для самостійної роботи 

Відповідно до запропонованого варіанту для певного адміністративного 

району використовуючи статистичні матеріали чисельності власників землі та 

землекористувачів Волинської області у розрізі сільських, селищних та 

міських рад та статистичні матеріали чисельності населення центрів 

адміністративних утворень Волинської області  засобами ГІС MapInfo 

Professional 5.0: 1 – змініть структуру шару центрів сільських, селищних та 

міських рад, певного адміністративного району доповнивши її новим полем 

типу Integer з іменами Чисельність_населення і заповніть таблицю 

атрибутивних даних показниками чисельності населення; 2 – створіть макет 

карти з тематичними шарами чисельності власників землі та землекористувачів 

адміністративних утворень району (спосіб ізоліній), показників чисельності 

населення центрів сільських, селищних та міських рад адміністративного 

району (значковий спосіб). 

Використовуючи правила оформлення додрукового макету у ГІС MapІnfo 

Professional 5.0, сформувати документ із результатами виконання завдань 

самостійної роботи і оформити його відповідно до поданого зразка (рис. 7.18).  
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Рис. 7.18. Приклад оформлення додрукового макету самостійної роботи № 7 
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Варіанти завдань для самостійної роботи 

Варіант № 1. Володимир-Волинський район 

№ 
з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Володимир-Волинський 38894 

2 Устилуг 2205 

3 Березовичі 670 

4 Білин 437 

5 Бубнів 613 

6 Галинівка 343 

7 Заріччя 1590 

8 Зимне 943 

9 Зоря 338 

10 Красностав 517 

11 Ласків 681 

12 Лудин 565 

13 Льотниче 1168 

14 Микитичі 393 

15 Овадне 1256 

16 П'ятидні 841 

17 Рогожани 398 

18 Селець 418 

19 Стенжаричі 492 

20 Хмелівка 487 

21 Хобултова 731 

22 Хотячів 275 
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Варіант № 2. Горохівський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Берестечко 1796 

2 Горохів 9186 

3 Мар'янівка 5000 

4 Сенкевичівка 1347 

5 Бережанка 548 

6 Брани 759 

7 Бужани 1086 

8 Ватин 325 

9 Вільхівка 711 

10 Галичани 735 

11 Горішнє 512 

12 Губин Перший 449 

13 Жабче 429 

14 Журавники 842 

15 Звиняче 1165 

16 Квасів 575 

17 Колодеже 584 

18 Лемешів 513 

19 Лобачівка 841 

20 Мерва 560 

21 Мирків 629 

22 Мирне 1222 

23 Михлин 325 

24 Новосілки 531 

25 Перемиль 1041 

26 Печихвости 997 

27 Підбереззя 1020 

28 Пірванче 669 

29 Піски 730 

30 Пустомити 600 

31 Рачин 386 

32 Скірче 503 

33 Скобелка 1602 

34 Скригове 402 

35 Смолява 707 

36 Терешківці 510 

37 Угринів 731 

38 Холонів 846 

39 Цегів 974 

40 Шклинь 843 
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Варіант № 3. Іваничівський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Нововолинськ 57936 

2 Іваничі 7183 

3 Бужанка 785 

4 Грибовиця 933 

5 Гряди 780 

6 Жашковичі 580 

7 Заболотці 1027 

8 Завидів 658 

9 Заставне 850 

10 Колона 605 

11 Литовеж 1507 

12 Луковичі 454 

13 Милятин 660 

14 Мишів 884 

15 Мовники 606 

16 Морозовичі 929 

17 Павлівка 914 

18 Переславичі 646 

19 Поромів 839 

20 Радовичі 451 

21 Риковичі 1024 

22 соснина 601 

23 Стара Лішня 424 

24 Старий Порицьк 435 

25 Топилище 529 
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Варіант № 4. Камінь-Каширський район 

№ 
з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Камінь-Каширський 12000 

2 Боровне 786 

3 Брониця 3582 

4 Бузаки 1066 

5 Великий Обзир 718 

6 Верхи 587 

7 Видерта 2313 

8 Видричі 701 

9 Воєгоща 1740 

10 Ворокомне 1902 

11 Грудки 1870 

12 Гута-Боровенська 967 

13 Добре 1339 

14 Залісся 1321 

15 Карасин 12126 

16 Качин 1537 

17 Клітицьк 344 

18 Личини 681 

19 Мельники-Мостище 756 

20 Нові Червища 1243 

21 Нуйно 1681 

22 Оленине 1057 

23 Осівці 1196 

24 Піщане 1350 

25 Пнівне 583 

26 Полиці 746 

27 Раків Ліс 3102 

28 Сошичне 1949 

29 Стовбихівка 908 

30 Тоболи 1155 

31 Хотешів 1800 

32 Черче 1835 
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Варіант № 5. Ківерцівський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Ківерці 14916 

2 Олика 3127 

3 Цумань 6235 

4 Берестяне 1017 

5 Борохів 1054 

6 Грем'яче 715 

7 Дідичі 1072 

8 Дерно 2120 

9 Дубище 355 

10 Жидичин 1396 

11 Жорнище 959 

12 Журавичі 1309 

13 Завітне 445 

14 Звірів 670 

15 Карпилівка 1699 

16 Липне 1976 

17 Озеро 690 

18 Озерце 416 

19 Омельне 809 

20 Покашів 1025 

21 Прилуцьке 2000 

22 Сильне 619 

23 Сокиричі 640 

24 Суськ 517 

25 Тростянець 843 

26 Холоневичі 1158 

27 Хорлупи 711 
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Варіант № 6. Ковельський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Ковель 69329 

2 Голоби 4131 

3 Люблинець 4477 

4 Білашів 493 

5 Білин 1259 

6 Велицьк 688 

7 Городище 210 

8 Доротище 468 

9 Дроздні 729 

10 Дубове 1454 

11 Зелена 758 

12 Козлиничі 506 

13 Колодяжне 720 

14 Кричевичі 818 

15 Любитів 1436 

16 Майдан 192 

17 Мельниця 573 

18 Мощена 602 

19 Новий Мосир 219 

20 Облапи 916 

21 Підріжжя 733 

22 Пісочне 811 

23  Поворськ 1875 

24 Поповичі 350 

25 Радошин 500 

26 Ситовичі 332 

27 Сільце 468 

28 Скулин 943 

29 Старі Кошари 476 

30 Тойкут 507 

31 Уховецьк 824 
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Варіант № 7. Локачинський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Локачі 3941 

2 Білопіль 389 

3 Бубнів 387 

4 Війниця 298 

5 Дорогиничі 620 

6 Замличі 307 

7 Затурці 1917 

8 Заячиці 459 

9 Зубильне 455 

10 Кисилин 331 

11 Козлів 431 

12 Колпитів 611 

13 Конюхи 780 

14 Крухиничі 711 

15 Марковичі 355 

16 Озютичі 428 

17 Привітне 1351 

18 Старий Загорів 747 

19 Холопичі 1142 

20 Шельвів 580 
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Варіант № 8. Луцький район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Луцьк 216714 

2 Рокині 1511 

3 Торчин 4474 

4 Білосток 380 

5 Баїв 659 

6 Баків 361 

7 Боголюби 851 

8 Боратин 1095 

9 Буяни 878 

10 Веселе 676 

11 Воютин 752 

12 Гірка Полонка 2658 

13 Городище 613 

14 Забороль 1346 

15 Коршів 683 

16 Лаврів 1164 

17 Липини 2871 

18 Лище 1733 

19 Маяки 2168 

20 Несвіч 806 

21 Одеради 339 

22 Підгайці 4240 

23 Піддубці 1037 

24 Промінь 527 

25 Радомишль 805 

26 Ратнів 888 

27 Романів 774 

28 Садів 830 

29 Смолигів 496 

30 Хорохорин 668 

31 Чаруків 1163 

32 Шепель 455 
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Варіант № 9. Любешівський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Любешів 7645 

2 Бірки 1599 

3 Березичі 798 

4 Бихів 1172 

5 Велика Глуша 1877 

6 Великийц Курінь 776 

7 Ветли 1826 

8 Гірки 778 

9 Деревок 922 

10 Ддольськ 791 

11 Залаззя 1891 

12 Залізниця 1423 

13 Зарудчі 1190 

14 Любязь 1061 

15 Любешівська Воля 544 

16 Мала Глуша 1547 

17 Седлище 1217 

18 Судче 1105 

19 Хоцунь 389 

20 Цир 1207 

21 Щитинь 701 
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Варіант № 10. Любомльський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Любомль 10300 

2 Головне 3055 

3 Бірки 723 

4 Вишнів 1187 

5 Гуща 945 

6 Заболоття 686 

7 Забужжя 829 

8 Запілля 656 

9 Зачернеччя 618 

10 Згорани 1381 

11 Куснища 1800 

12 Ладинь 218 

13 Маршів 735 

14 Нудиже 809 

15 Олеськ 856 

16 Підгородне 389 

17 Полани 1083 

18 Почапи 458 

19 Рівне 1000 

20 Радехів 667 

21 Римачі 942 

22 Столинські Смоляри 661 

23 Хворостів 594 
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Варіант № 11. Маневицький район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Маневичі 11600 

2 Колки 4890 

3 Боровичі 1109 

4 Будки 450 

5 Велика Ведмежка 313 

6 Велика Осниця 668 

7 Галузія 757 

8 Годомичі 877 

9 Гораймівка 1640 

10 Городок 1086 

11 Довжиця 368 

12 Карасин 732 

13 Комарове 931 

14 Копилля 878 

15 Костюхнівка 546 

16 Красноволя 801 

17 Кукли 935 

18 Куликовичі 819 

19 Лишнівка 632 

20 Лісове 555 

21 Нова Руда 532 

22 Оконськ 1229 

23 Прилісне 3120 

24 Рудники 1461 

25 Серхів 556 

26 Старосілля 1557 

27 Старий Чорторийськ 1829 

28 Троянівка 899 

29 Цміни 945 

30 Череваха 837 

31 Четвертня 1311 

32 Чорниж 1630 
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Варіант № 12. Ратнівський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Ратне 9843 

2 Заболоття 4299 

3 Велимче 2972 

4 Видраниця 1553 

5 Височне 421 

6 Гірники 2068 

7 Гута 1694 

8 Датинь 875 

9 Жиричі 2292 

10 Заброди 853 

11 Заліси 1427 

12 Залухів 424 

13 Замшани 1712 

14 Здомишель 914 

15 Кортеліси 1213 

16 Межисить 703 

17 Млинове 511 

18 Поступель 745 

19 Прохід 697 

20 Річиця 1285 

21 Самари 3000 

22 Самари-Оріхові 1082 

23 Тур 2264 

24 Ратне 9843 
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Варіант № 13. Рожищенський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Рожище 13441 

2 Дубище 1897 

3 Іванчиці 313 

4 Березолуки 390 

5 Береськ 705 

6 Вічині 435 

7 Ворончин 561 

8 Городині 296 

9 Доросині 1037 

10 Залісці 504 

11 Кобче 273 

12 Копачівка 1327 

13 Кременець 891 

14 Літогоща 294 

15 Луків 3000 

16 Любче 744 

17 Мильськ 466 

18 Навіз 1085 

19 Немир 493 

20 Носачевичі 289 

21 Переспа 1099 

22 Пожарки 709 

23 Рудка-Козинська 752 

24 Рудня 618 

25 Сокіл 797 

26 Тихотин 310 

27 Топільне 1300 

28 Уляники 596 

29 Щурин 673 

30 Ясенівка 486 
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Варіант № 14. Старовижівський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Стара Вижівка 5161 

2 Буцин 1181 

3 Галина Воля 707 

4 Глухи 964 

5 Дубечне 2395 

6 Журавлине 514 

7 Кримне 2019 

8 Любохини 2036 

9 Мизове 1000 

10 Нова Вижівка 638 

11 Поліське 459 

12 Рудня 305 

13 Седлище 705 

14 Секунь 590 

15 Сереховичі 883 

16 Синове 636 

17  Смідин 2265 

18 Соколище 232 

19 Солов'ї 337 

20 Стара Гута 1161 
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Варіант № 15. Турійський район 

№ 

з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Турійськ 5697 

2 Луків 3088 

3 Бобли 956 

4 Гайки 211 

5 Дольськ 480 

6 Дуліби 505 

7 Клюськ 270 

8 Кульчин 532 

9 Купичів 854 

10 Маковичі 273 

11 Миляновичі 306 

12 Мокрець 728 

13 Новий Двір 469 

14 Новосілки 333 

15 Овлочин 581 

16 Озеряни 417 

17 Перевали 373 

18 Ружин 319 

19 Селець 514 

20 Соловичі 589 

21 Сомин 252 

22 Туличів 368 

 

Варіант № 16. Шацький район 

№ 
з/п 

Центр адміністративного 

утворення 
Чисельність населення, чол. 

1 Шацьк 5370 

2 Грабове 294 

3 Піща 1162 

4 Прип'ять 591 

5 Пулемець 667 

6 Пульмо 1403 

7 Ростань 410 

8 Самійличі 398 

9 Світязь 1845 
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